Hitachi Command Suite

Tuning Manager
Getting Started Guide

Hitachi Data Systems
# Contents

Preface ................................................................. vii

Intended audience .................................................. viii
Product version ...................................................... viii
Release notes ........................................................ viii
Document organization .......................................... viii
Referenced documents ........................................... ix
Document conventions .............................................. ix
Convention for storage capacity values ..................... x
Accessing product documentation ............................ xi
Getting help ............................................................ xi
Comments ............................................................... xi

1 Initial tasks .......................................................... 1-1

Tuning Manager overview ....................................... 1-2
Before you begin .................................................... 1-3
System requirements .............................................. 1-3
Setting up your browser ......................................... 1-3
Activating your license key ....................................... 1-4
Logging in to the Tuning Manager server ..................... 1-5
Viewing or editing your user account information ........ 1-5
Logging out ............................................................. 1-6
Overview of the GUI ................................................. 1-6
Using online help ................................................... 1-6
About user permissions .......................................... 1-7
Setting up users ..................................................... 1-8
Creating new user account ..................................... 1-8
Setting permissions for the user .............................. 1-8

2 Working with reports ............................................... 2-1

About Main Console and Performance Reporter .......... 2-2
Working with reports in Main Console ....................... 2-2
3 Acquiring data from Agents and Device Manager .................. 3-1
Using a Tuning Manager server to acquire data (polling) ........ 3-2
Data collected from an information source ......................... 3-2
Information resources for the monitoring host .................... 3-4
  Selecting a host's information source (Agentless host mode) .. 3-4
  Required conditions for enabling each host monitoring mode .. 3-5
  Switching monitoring mode ........................................ 3-5
  Differences in collected information by monitoring mode .... 3-5
Monitoring Agentless hosts ........................................... 3-7
  Adding an Agentless host as a monitoring target ............... 3-7
  Refreshing Agentless host information ........................... 3-8
  Updating configuration information ............................... 3-8
  Determining the current monitoring mode ....................... 3-9
  Switching the host monitoring mode from Agent to Agentless  .. 3-9
  Switching the host monitoring mode from Agentless to Agent  .. 3-9
  Deleting an Agentless host as a Tuning Manager monitoring target . 3-10
Configuring the polling settings .................................... 3-10
Checking the polling settings ...................................... 3-12
Editing the polling settings ........................................ 3-14
Data retention periods .............................................. 3-15
  Checking the data retention period settings .................... 3-16
  Editing the data retention periods ............................... 3-16

4 Using alarms to monitor operations ................................. 4-1
Overview of alarms ................................................... 4-2
Methods for setting and using alarms .............................. 4-2
  Task flow for setting and operating alarms .................... 4-3
Planning system monitoring ......................................... 4-4
Example of prerequisites for setting alarms ....................... 4-5
  Example of setting up email alerts for an alarm ............... 4-5
  Example of setting up an SNMP trap destination ............... 4-8
  Example of setting up the host to run commands ............... 4-11
Descriptions of settings when defining an alarm ................. 4-12
  Use the %CVS variable to represent the conditions value in notifications . 4-12
Example of a %CVS value used in the message of an alarm email notification or SNMP trap ........................................... 4-14
Example of using %CVS in an email subject of an alarm notification .. 4-15
Relate the data model version to the RAID product ...................... 4-16
Use “Monitor whether a value exists” for critical applications ...... 4-17
Use “Always notify” to receive notifications every time threshold is crossed 4-18
Use “Evaluate all data” to receive all notifications for multi-row records .. 4-19
Use “Monitoring time range” to limit notifications to certain time periods . 4-20
Use “Damping” to limit notifications .................................................... 4-21
Example of creating an alarm table and alarm ................................. 4-22
Settings for creating more alarms for the USP VM alarm table .... 4-32
Examples of email notifications ............................................................ 4-36
Monitoring Agents using Performance Reporter ............................. 4-38
Monitoring Events using Performance Reporter ............................. 4-39

5 Analyzing performance bottlenecks ................................. 5-1
Analyzing performance bottlenecks ............................................. 5-2
  Reviewing key points for analyzing performance bottlenecks ........ 5-2
  About the relationship between the system configuration and the analysis procedure ........................................... 5-2
  Resources to which performance bottleneck analysis can be applied .... 5-3
Analysis examples ................................................................. 5-4
  System configuration for monitoring example .............................. 5-4
  Procedures used to analyze the performance bottleneck .......... 5-5
  Identifying the host name based on the Oracle instance ............ 5-6
  Checking the I/O response time .............................................. 5-7
  Checking storage port performance .................................. 5-9
  Checking connected server performance .................................. 5-10

6 Frequently asked questions ........................................ 6-1
Login issues ........................................................................ 6-2
IP addresses ........................................................................ 6-2
Data collection .................................................................... 6-2
Agent management ............................................................... 6-2
Resource management .......................................................... 6-3
Report handling ................................................................... 6-4
Error detection ...................................................................... 6-4
Operations changes .............................................................. 6-5
Data recovery ...................................................................... 6-5

Index
Preface

This document outlines basic procedures to get you started on the Hitachi Tuning Manager software.

This preface includes the following information:

- Intended audience
- Product version
- Release notes
- Document organization
- Referenced documents
- Document conventions
- Convention for storage capacity values
- Accessing product documentation
- Getting help
- Comments
Intended audience

This Tuning Manager document is intended for the following users:

- System administrators
- Storage administrators
- Application developers
- System integrators
- Technology consultants
- System architects and capacity planners who rely on Hitachi Tuning Manager reports and forecasts

Product version

This document revision applies to Hitachi Tuning Manager v8.1.1.

Release notes

Release notes can be found on the documentation CD. Read the release notes before installing and using this product. They may contain requirements or restrictions that are not fully described in this document or updates or corrections to this document.

Document organization

The following table provides an overview of the contents and organization of this document. Click the chapter title in the left column to go to that chapter. The first page of each chapter provides links to the sections in that chapter.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial tasks on page 1-1</td>
<td>Introduces the Hitachi Tuning Manager. Describes different types of login permissions and introduces the graphical user interface.</td>
</tr>
<tr>
<td>Working with reports on page 2-1</td>
<td>Covers key topics for creating and managing Tuning Manager server user accounts.</td>
</tr>
<tr>
<td>Acquiring data from Agents and Device Manager on page 3-1</td>
<td>Describes the functions for acquiring data from Agents and Device Manager and how to specify the settings for data acquisition.</td>
</tr>
<tr>
<td>Using alarms to monitor operations on page 4-1</td>
<td>Describes how to use the GUI to set up alarms and how to set them to notify you of problems.</td>
</tr>
<tr>
<td>Analyzing performance bottlenecks on page 5-1</td>
<td>Describes how to analyze performance bottlenecks by using Tuning Manager server reports, and it provides an example analysis procedure.</td>
</tr>
<tr>
<td>Frequently asked questions on page 6-1</td>
<td>Answers to questions that are often raised when working with Tuning Manager.</td>
</tr>
</tbody>
</table>
Referenced documents

The following Hitachi referenced documents can be found on the applicable documentation CD:

- Tuning Manager Agent Administration Guide, MK-92HC013
- Tuning Manager Server Administration Guide, MK-92HC021
- Tuning Manager User Guide, MK-92HC022
- Tuning Manager Hardware Reports Reference, MK-95HC111
- Tuning Manager Operating System Reports Reference, MK-95HC112
- Tuning Manager Application Reports Reference, MK-95HC113
- Tuning Manager Messages, MK-95HC114
- Tuning Manager CLI Reference Guide, MK-96HC119
- Tuning Manager Installation Guide, MK-96HC141
- Tuning Manager API Reference Guide MK-92HC218
- Hitachi Command Suite System Requirements MK-92HC209
- Hitachi Command Suite Help

Document conventions

This document uses the following typographic conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Indicates text on a window, other than the window title, including menus, menu options, buttons, fields, and labels. Example: Click OK.</td>
</tr>
<tr>
<td>Italic</td>
<td>Indicates a variable, which is a placeholder for actual text provided by the user or system. Example: copy source-file target-file</td>
</tr>
<tr>
<td>Monospace</td>
<td>Indicates text that is displayed on screen or entered by the user. Example: # pairdisplay -g oradb</td>
</tr>
<tr>
<td>&lt; &gt; angled brackets</td>
<td>Indicates a variable, which is a placeholder for actual text provided by the user or system. Example: # pairdisplay -g &lt;group&gt; Note: Angled brackets (&lt; &gt;) are also used to indicate variables.</td>
</tr>
<tr>
<td>[ ] square brackets</td>
<td>Indicates optional values. Example: [ a</td>
</tr>
<tr>
<td>{ } braces</td>
<td>Indicates required or expected values. Example: { a</td>
</tr>
<tr>
<td></td>
<td>vertical bar</td>
</tr>
</tbody>
</table>

This document uses the following icons to draw attention to information:
**Convention for storage capacity values**

Physical storage capacity values (for example, disk drive capacity) are calculated based on the following values:

<table>
<thead>
<tr>
<th>Physical capacity unit</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 kilobyte (KB)</td>
<td>1,000 (10^3) bytes</td>
</tr>
<tr>
<td>1 megabyte (MB)</td>
<td>1,000 KB or 1,000(^2) bytes</td>
</tr>
<tr>
<td>1 gigabyte (GB)</td>
<td>1,000 MB or 1,000(^3) bytes</td>
</tr>
<tr>
<td>1 terabyte (TB)</td>
<td>1,000 GB or 1,000(^4) bytes</td>
</tr>
<tr>
<td>1 petabyte (PB)</td>
<td>1,000 TB or 1,000(^5) bytes</td>
</tr>
<tr>
<td>1 exabyte (EB)</td>
<td>1,000 PB or 1,000(^6) bytes</td>
</tr>
</tbody>
</table>

Logical storage capacity values (for example, logical device capacity) are calculated based on the following values:

<table>
<thead>
<tr>
<th>Logical capacity unit</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 block</td>
<td>512 bytes</td>
</tr>
<tr>
<td>1 KB</td>
<td>1,024 (2^{10}) bytes</td>
</tr>
<tr>
<td>1 MB</td>
<td>1,024 KB or 1,024(^2) bytes</td>
</tr>
<tr>
<td>1 GB</td>
<td>1,024 MB or 1,024(^3) bytes</td>
</tr>
<tr>
<td>1 TB</td>
<td>1,024 GB or 1,024(^4) bytes</td>
</tr>
<tr>
<td>1 PB</td>
<td>1,024 TB or 1,024(^5) bytes</td>
</tr>
<tr>
<td>1 EB</td>
<td>1,024 PB or 1,024(^6) bytes</td>
</tr>
</tbody>
</table>

**Accessing product documentation**

The Tuning Manager user documentation is available on the Hitachi Data Systems Portal: [portal.hds.com/](http://portal.hds.com/). Check this site for the most current documentation, including important updates that may have been made after the release of the product.
Getting help

Hitachi Data Systems Support Portal is the destination for technical support of your current or previously-sold storage systems, midrange and enterprise servers, and combined solution offerings. The Hitachi Data Systems customer support staff is available 24 hours a day, seven days a week. If you need technical support, log on to the Hitachi Data Systems Support Portal for contact information: https://portal.hds.com/

Hitachi Data Systems Community is a new global online community for HDS customers, partners, independent software vendors, employees, and prospects. It is an open discussion among these groups about the HDS portfolio of products and services. It is the destination to get answers, discover insights, and make connections. The HDS Community complements our existing Support Portal and support services by providing an area where you can get answers to non-critical issues and questions. **Join the conversation today!** Go to community.hds.com, register, and complete your profile.

Comments

Please send us your comments on this document: doc.comments@hds.com. Include the document title, number, and revision, and refer to specific sections and paragraphs whenever possible. All comments become the property of Hitachi Data Systems Corporation.

Thank you!
Initial tasks

This chapter provides you an overview of the Tuning Manager series and outlines basic procedure to get you started on the application. This guide assumes that the Tuning Manager series is already installed and running on your system. For more information on installation procedures, see Tuning Manager Installation Guide.

This chapter includes the following topics:

- Tuning Manager overview
- Before you begin
- Activating your license key
- Logging in to the Tuning Manager server
- Overview of the GUI
- Using online help
- About user permissions
- Setting up users
**Tuning Manager overview**

The Tuning Manager series is a real-time software monitor that you can use to check the current state of all the host, file system, database, SAN (Storage Area Network), and storage resources that are used by the applications. It lets you compare the current data of monitored resources with a historical view of the normal, baseline performance of those resources that was stored in the database. The ability to query a historical database for performance and capacity trend analysis for each component of a SAN lets you to easily correlate the current changes in performance with recent changes to the physical configuration, software, or workload, or with other environmental changes that might cause changes in the application performance.

The goal of every IT organization is to detect and resolve potential problems before they occur. The Tuning Manager series lets you to define, monitor and store critical performance and capacity thresholds, and send warnings to appropriate people to alert them of potential problems.

The Tuning manager series is actually a series of software components that work together to monitor an entire network and collect performance data from the various systems. The Tuning Manager series consists of Agents, which collect the performance data for each monitored resource, and the actual Tuning Manager server, which manages all the Agents.

Device Manager collects and manages the configuration information of storage devices and virtualization environments. Device Manager is a prerequisite product for the Tuning Manager server. The following figure shows an example of the Tuning Manager series system configuration.

A Tuning Manager server collects, stores, and analyzes hundreds of metrics that are available to you as reports. Tuning Manager server reports can be requested for a real-time monitoring or as a historical trend analysis over a specified time period. You can also use the historical reports to forecast future trends.
Before you begin

Before you begin make sure you meet the prerequisites. The following topics explain the minimum client system requirements and browser settings.

System requirements

For information about system requirements, see *Hitachi Command Suite System Requirements*.

Tuning Manager server supports Internet browsing with browsers such as Internet Explorer and Firefox. For a list of supported browsers, see the section on supported browsers in *Hitachi Command Suite System Requirements*.

Setting up your browser

The following table shows the required browser settings.
Table 1-1 Browser settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Internet Explorer</td>
</tr>
<tr>
<td>Languages</td>
<td>Specify the language you want to use.</td>
</tr>
<tr>
<td>Page Cache</td>
<td>Specify that the latest information be displayed each time the user accesses a page.</td>
</tr>
</tbody>
</table>

**Related topics**
- For more browser-settings requirements, see the *Hitachi Command Suite User Guide*.
- For details about the items and how to specify them, refer to the documentation for the applicable browser.
- For a list of supported browsers, see “Supported browsers” in the Release Notes.

**Activating your license key**

You must register your license key before logging in to the Tuning Manager server.

**To register your license:**

1. Launch the Tuning Manager server by entering a URL consisting of the name of the host on which the Tuning Manager server is installed, and the port number.
   
   In the following example, the host name is `host01` and the port number is 23015:
   
   **Example:** `http://host01:23015/TuningManager/`
   
   The title screen appears, and you are automatically navigated to the login window.

2. If you are not automatically navigated to the login window, click **Log in** from the title window.
   
   The login window appears.

3. You can enter or edit your license key in the **License Console** dialog. You can display the **License Console** dialog by performing any of the following actions:
   - Before you log in to the server, click **License** from the login window.
• After you log in to the server do one of the following: From the application menu bar, select Help > About or from the Explorer menu, select Settings > License Info.

4. In the License Console dialog perform the following steps:
   • Select the Key radio button to directly enter the license key.
   • Select the File radio button to browse and attach a license key file.

5. Click Save.

Note: For more information on managing licenses, see the Tuning Manager Server Administration Guide.

Logging in to the Tuning Manager server

You can log in to the Tuning Manager server as an administrator or as a user. The tasks that you can perform after you log in depend on the user permission assigned to you.

To login:
1. Launch the Tuning Manager server by entering a URL consisting of the name of the host on which the Tuning Manager server is installed, and the port number.
   In the following example, the host name is host01 and the port number is 23015:
   Example: http://host01:23015/TuningManager/
   The title screen appears, and you are automatically navigated to the login window.

2. If you are not automatically navigated to the login window, click Log in from the title window.

3. In the login window, enter your user ID and password and click Log in.
   You are navigated to the Tuning Manager main window.

Note: When you log in to the Tuning Manager for the first time with admin permissions, use the default user Id and password. Hitachi Command Suite products include a built-in account.

User ID: system
Password: manager
Make sure you change the password at the first login.

Viewing or editing your user account information

You can view or edit your user account information.

1. In the main window, go to Explorer menu, select Settings > User Profile.
   The User Profile window appears. In this window you can view the profile and permissions.

2. In the User Profile window:
- Click **Edit Profile** to edit the profile.
- Click **Change Password** to change your password

**Logging out**

To exit the application, perform the following steps:

1. Click **Logout** in the global tasks bar area, or choose **Logout** from the **File** menu. Note that in the Single Sign-On (SSO) mode, this operation also closes other Hitachi Command Suite products. To close only the Tuning Manager server, click the **Close** link in the global tasks bar area or choose **Close** from the **File** menu.

**Overview of the GUI**

You are navigated to the Tuning Manager main window each time you log in. For more information on navigating the main window, see the *Tuning Manager User Guide*. The following figure describes the GUI components.

![Figure 1-2 Components of the main window](image)

**Note:**

- In addition to the GUI, you can interact with the Tuning Manager server with a command line interface (CLI). This comprehensive text-based command interface can accomplish all the tasks performed by the GUI. For details on using the CLI, see the *Tuning Manager CLI Reference Guide*.

- Do not use web browser functions such as **Refresh**, **Back**, and **Close** to navigate, because they might display inappropriate result window and sometimes you may have to login again. Always use the links and buttons in the Tuning Manager server main window to perform GUI operations.

**Using online help**

You can access the Online help for any assistance.
To access Online help
1. In the application menu bar, go to Help menu and select Help.
   Alternatively, press the Help button available in dialog boxes, report
   windows to view the context sensitive help information.

About user permissions

User management capability that is common across Hitachi Command Suite
products lets you set the following permissions for each user:

- User Management permissions
- Operational permissions for the Tuning Manager server
- Permissions for Hitachi Command Suite products, except the Tuning
  Manager server. For details, see the manual for the relevant product.

The following table describes the permissions relating to Tuning Manager
server users.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Permission</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tuning Manager server operations</td>
<td>Admin</td>
<td>Lets users change the settings for the functions provided by the Tuning</td>
<td>A user who has only this permission cannot use the user management</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manager server. If you apply Admin permissions to a user, the View</td>
<td>capability of Hitachi Command Suite products.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>permission is also set.</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td></td>
<td>Lets users view the available range of resources.</td>
<td></td>
</tr>
<tr>
<td>User management</td>
<td>User Management</td>
<td>Lets user create and manage user accounts and assign permissions. You can</td>
<td>• You cannot change the permissions for the HaUser account. This</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set this permission in combination with any of the Tuning Manager server</td>
<td>account is the default user for the Device Manager agent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>operation permissions.</td>
<td>• You cannot change the permissions associated with the system</td>
</tr>
</tbody>
</table>
<pre><code>                             |                    |                                                                            | account.                                                             |
</code></pre>
Setting up users

With the user management permission, you can create and assign permissions for the user account common to all Hitachi Command Suite products.

If you edit the exauth.properties file of the Tuning Manager server to specify the settings for linking with an external authentication server, external authentication is the default method used to authenticate the user to be added. For more information on the exauth.properties file, see Hitachi Command Suite Administration Guide.

Creating new user account

You can create new user account by following the steps listed below:

1. In the explorer area, choose Administration > Users and Permissions.

2. In the navigation area, select Users.

3. In the Users window, click Add User.

4. In the Add User dialog, enter the User ID, Password, and other optional information.

5. Click OK.

The user account is created. The account appears in User List.

Setting permissions for the user

After creating the user account, you have to assign operating permissions for the user.

1. In the explorer area, choose Administration > Users and Permissions.

2. In the navigation area, expand the Users object tree, and select the user ID for which you want to set permissions.

The User-ID window appears in the application area. Here you can view the permissions already set for the user.

3. In the User-ID window, Click Change Permissions.

The Change Permission - user-ID dialog box appears.

4. Select the permissions for each application, and then click OK to save the settings.

Note: For the new user to view Device Manager resource information, you must set Device Manager permission (Admin, Modify, or View) and assign a resource group. For more information about assigning a resource group, see the Hitachi Command Suite Help.
Working with reports

The metrics collected by agents can be displayed in main console as graphs and tables. The graphical representation of metrics collected by Agents is called reports. Reports lets you analyze the performance of hosts and storage systems based on monitored targets and manage their capacities.

This chapter includes the following topics:

- About Main Console and Performance Reporter
- Working with reports in Main Console
- About Performance Reporter reports
About Main Console and Performance Reporter

The Tuning Manager server has the following two views: Main Console and Performance Reporter.

- **Main Console**: Main Console stores the configuration and capacity information that the Agents and Device Manager collect from the monitored resources in a database. You can use Main Console to display reports in which the data accumulated in the database is mapped to the performance data managed by the Agents over a specified time frame. The Tuning Manager server database is managed by the Highly-scalable Relational Database (HiRDB).

- **Performance Reporter**: Performance Reporter displays performance data collected directly from the Store database of each Agent and provides a simple menu-driven method to customize your reports. Performance Reporter allows you to display reports in which the current status of monitored targets is shown in real time. Performance Reporter does not connect to HiRDB. You can access performance reporter from Main Console.

Working with reports in Main Console

This topic describes the reports from Main Console, and includes the following information:

- Features of reports displayed in Main Console on page 2-2
- Types of reports displayed in Main Console on page 2-4
- Displaying the main report in main console on page 2-5

Features of reports displayed in Main Console

The reports displayed in Main Console allow you to perform the following operations:

- Obtain an overview of the system, perform comparative data analysis, and understand trends.

- Display a summary of resource configuration and capacity data that is stored in the Tuning Manager server database.

- Display a summary of resource performance data that is stored in the store databases of Agents.

- Display a summary of the resources related to the resources displayed in a report.

- Simplify analysis tasks, such as comparing data at different points in time, by allowing each user to define and retain time ranges for displaying data.

- Display detailed reports suitable for your needs from reports displayed in Main Console. Detailed reports show historical data, future forecasts, and the relationship between resources.
• Register detailed reports that show historical data and future forecasts as original reports. These original reports can be registered in Main Console as favorites. The favorites functionality allows you to register frequently referenced graphs and display them quickly. You can specify your own registration and display settings, and share it with other users.

⚠️ **Note:** The display formats for the graphs are fixed.

• Use Adobe Flash Player to display historical and forecast (trend chart) reports. Flash mode provides the following capabilities:
  - Magnify and reduce the size of items in reports
  - Change the size of the display range in reports
  - Check performance information and the acquisition time of displayed data on reports

For information about switching to Flash mode, see *Tuning Manager User Guide*.

By analyzing the reports displayed in Main Console, your organization can:
• Identify storage systems on the network.
• Determine how many hosts exist on your network and its subnetworks.
• Measure storage capacity network-wide and at progressively lower levels of your network.
• Quantify file systems and the total, used, and remaining capacity.
• Detect and prevent capacity shortages.
• Rearrange files and file systems for effective capacity and performance use.
• Detect performance bottlenecks in storage systems or on hosts.
• Determine when to add a drive to your storage system.
• Understand the relationships established among host file systems, logical devices, and corresponding drives.
• Understand the RAID configuration of storage devices (which include systems, ports, LDEVs, and parity groups) associated with host file systems.
• Ensure that the logical volumes are configured correctly for the applications accessing data stored in the host file systems.
• View the LDEVs (extents) that make up a datastore and the storage system associated with those LDEVs, from Datastores in Hypervisors.

**Note:** The following issues apply to metrics:

- The metrics displayed in Main Console are a part of the data that Agents collect. To view data that is not displayed in Main Console, use Performance Reporter. For details about the data that is collected by Agents, see the following manuals:
  - Tuning Manager Hardware Reports Reference
  - Tuning Manager Operating System Reports Reference
  - Tuning Manager Application Reports Reference

- In certain circumstances, the Tuning Manager server cannot provide metrics for particular resources. This is the result of the limitations of certain operating systems, software, and hardware. For details, see the Tuning Manager User Guide.

**Types of reports displayed in Main Console**

The main report is displayed in the application area of the main window. The report components are briefly described in the Table 2-1.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource summary (configuration data and capacity data)</td>
<td>The configuration data and capacity data of target resources at a specific time(^1) are displayed in list format.</td>
</tr>
<tr>
<td>Resource summary (performance data and capacity data)</td>
<td>Performance data and capacity data are displayed in a time series(^1) in chart format(^2) according to the settings of the report window. Two types of data are displayed in chart format: data defined by the system and data defined by a user. You cannot customize data that is defined by the system.</td>
</tr>
<tr>
<td>Summary of the resources related to the target resource (configuration data and capacity data)</td>
<td>The configuration data and capacity data of the resources related to the target resource at a specific time (^1) are displayed in table format.</td>
</tr>
</tbody>
</table>

**Note 1:**

You can specify time-related settings in the title area of the window. For details, see the Tuning Manager User Guide

**Note 2:**

You can specify chart display settings in the Dashboard page in the information area of the Main Report window. For details, see the Tuning Manager User Guide.

From the main report, you can display the following types of reports to further analyze metrics:

- Performance Reporter report
The performance and capacity data displayed in the main report can be analyzed and displayed in detail in Performance Reporter reports. For more information on how to display reports using Performance Reporter, see About Performance Reporter reports on page 2-8.

- **Correlation report**
  The performance data collected from different correlated resources over a specific time period is displayed in chart format.

- **Historical report**
  The performance and capacity data collected from the target resources over a specific time period is displayed in chart format.

- **Forecast report**
  The performance and capacity data collected from the target resources over a specific time period is used to forecast the expected values in chart format.

- **Trend chart report**
  You can register historical reports and forecast reports as favorites on the Dashboard page in the title area of the main report window. Registered reports are displayed in the main report window as thumbnails. These reports are called trend chart reports. If multiple reports are registered and displayed as trend chart reports, you can display one or more reports in full size in one window.

- **Performance summary report (correlated resources)**
  The performance and capacity data of correlated resources at a specific time are displayed in table format.

- **Historical report (correlated resources)**
  The performance and capacity data of correlated resources at a specific time are displayed in chart format.

---

**Note:** For storage system identification, the following reports display the storage system name and serial number under each report title.

- Correlation report
- Historical report (other than Tiered Storage Manager)
- Forecast report
- Performance summary report

This information is displayed when a port, parity group, LDEV, or other storage system resource is selected in the navigation area.

---

**Displaying the main report in main console**

This section describes how to display the main report.

To display a report:

1. In the **Explorer** menu, select **Resources**, and then select the resource for which you want to display reports.
   - Information about the top-level resource appears in the report area.
2. In the navigation area, you can expand the resource tree to select the next level of resources.

Information about the selected resource appears in the application area as the main report.

Table 2-2 Application area components on page 2-6 describes the information displayed in each area of the application area.

**Note:** When the Tuning Manager server is polling, displaying resource information might take a long time. If you have Admin (application management) permission, you can use the Administration menu displayed in the explorer area to make sure that the server is not polling. For more information, see the descriptions of polling settings and system reports in the Tuning Manager Server Administration Guide.

<table>
<thead>
<tr>
<th>Area name</th>
<th>Displayed information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title area</td>
<td>This area displays information such as the application area title, hierarchical level (crumb trail), and report window.</td>
</tr>
<tr>
<td>Summary area</td>
<td>This area displays a table that lists capacity data and configuration data at a specific time (the end of the time period specified in the report window) for the resource selected from the tree in the navigation area. The displayed data includes the data of any resources related to the selected resource. This information is useful as an overview of resources.</td>
</tr>
</tbody>
</table>
| Information area (Dashboard)   | This area displays trend chart reports that list performance data and capacity data for the resource selected from the resource tree in the navigation area. In trend chart reports, the following types of charts are displayed:
  - Trend charts defined by the system
    Data for the past six months is displayed on a monthly basis.
  - Trend charts defined by a user
    Data is displayed based on the time period and time unit specified in the report window.
This area displays the thumbnails of charts. When a thumbnail is selected, the corresponding full size chart is displayed in a new window. |
| Information area (Correlation View) | This area displays detailed information about the resource selected in the navigation area, as well as the configuration data and capacity data of the resources related to the selected resource. For example, when Systems is selected in the navigation area, information about ports, parity groups, LDEVs, and other resources are displayed. To display other information, select the desired tab in the report. The data of the resource displayed in this area can also be displayed in a new window as a report. |
The following table describes the operations that you can perform in the main report window. Depending on the type of resources displayed in the main report window, the information that is displayed will differ. For details, see the Tuning Manager User Guide.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>To show the status of the currently-displayed resource at a specified time or generic time period</td>
<td>In the report window, select the time interval from the drop-down list and then click <strong>Apply</strong>.</td>
</tr>
<tr>
<td>To find past trends of performance and capacity data for resources</td>
<td>In the application title bar, click the <strong>Historical Report</strong>.</td>
</tr>
<tr>
<td>To find future trends of performance and capacity data for resources</td>
<td>In the application title bar, click the <strong>Forecast Report</strong>.</td>
</tr>
<tr>
<td>To compare performance data trends between different time periods, or to compare performance data trends between resources and their correlated resources</td>
<td>In the application title bar, click the <strong>Correlation Wizard</strong>.</td>
</tr>
<tr>
<td>To find out about detailed trends of performance and capacity data for resources</td>
<td>In the application title bar, click the <strong>Performance Reporter</strong>.</td>
</tr>
<tr>
<td>To display a trend chart of performance and capacity data</td>
<td>Choose the <strong>Dashboard</strong> page in the information area, and then click the displayed chart. Alternatively, click the <strong>Open</strong> on the <strong>Dashboard</strong> page.</td>
</tr>
<tr>
<td>To filter the displayed information of correlated resources</td>
<td>Display correlated resources that you want to filter, and then click <strong>Filter</strong>. In the Filter - resource-name window, specify the display conditions, and then click <strong>OK</strong>. <strong>Note:</strong> If you specify = or &lt;&gt; as the filtering condition and no data is extracted, filter the resources by specifying a range (by using &lt;, &gt;, &gt;=, or &lt;=).</td>
</tr>
<tr>
<td>To display all information of correlated resources</td>
<td>Display the correlated resources, and then click <strong>Filter Off</strong>.</td>
</tr>
<tr>
<td>To display a summary of performance data</td>
<td>Click <strong>Performance Summary</strong>.</td>
</tr>
<tr>
<td>To find out about past trends of the performance and capacity data of correlated resources</td>
<td>Select the check box of correlated resources, and then click <strong>Historical Report</strong>.</td>
</tr>
</tbody>
</table>
About Performance Reporter reports

Performance Reporter displays the performance data collected by Agents in graphical format. The graphical representation of data is defined as reports.

Launching Performance Reporter

If you launch Performance Reporter from the Tuning Manager server main window, the Performance Reporter main window or the Report Tree Selection window is displayed as a separate window. Only one of these windows can be open at a time. If you launch Performance Reporter again, the new window is displayed by overwriting the already open window, not by displaying a separate window.

You can launch Performance Reporter from the Tuning Manager server main window in either of the following ways:

- By using the Performance Reporter button in the application bar area of the Tuning Manager server main window
- By using the global tasks bar area of the Tuning Manager server main window

To use the Performance Reporter button in the application bar area of the Tuning Manager server main window:

1. Make sure that a report is displayed in the Tuning Manager server main window, and then click the Performance Reporter button in the application bar area. Alternatively, choose Resources and then NASs/Other Apps in the explorer area, and then click the Agent displayed in the application bar area.

2. Performance Reporter displays the Report Tree Selection window of the Agent that is linked to the information in the source from which you opened Performance Reporter.

3. If you want to display the Performance Reporter main window when Performance Reporter is launched, edit the user.properties file. For details on how to edit this file, see the chapter that describes how to specify settings for the user.properties file in the Tuning Manager Server Administration Guide.

Features of reports displayed in Performance Reporter

Performance Reporter reports allow you to perform the following operations:

- Analyze trends and performance in detail
- Display detailed data by the minute
- Specify the display formats of graphs and change time ranges
- For historical reports, display data stored in Store databases of Agents
- Display all data collected by Agents
- Display data from single-instance records or multi-instance records
- Output CSV or HTML files
- Display different historical reports in one report
Types of reports displayed in Performance Reporter

Performance Reporter can display historical reports and real-time reports. A historical report displays data from a specified interval of time. A real-time report displays temporarily collected, current data. You can select from the following report types:

- Historical report (single Agent): Displays one report window for each Agent. When multiple Agents are selected, the report displays as many windows as the number of Agents. A single-Agent historical report includes the following record types:
  - Single-instance record. A record that is recorded in one row each time data is collected. In Performance Reporter, each row in a record is called an instance.
  - Multi-instance record. A record that is recorded in more than one row each time data is collected. This record can be useful when comparing values for the same field among various Agents.

- Historical report (multiple Agents): Displays all selected Agents in one window, regardless of whether you select one report or multiple reports.

- Real-time report (single Agent): Displays current data for one Agent that has been temporarily collected. The collected values can be displayed in order and ranked. The report supports data from single instance or multi-instance records. Past data cannot be displayed—it is not stored in the Store database.

Performance Reporter provides both normal and combination reports. A combination report combines multiple historical reports in the same graph. By registering reports that combine report definitions from multiple Agents in a bookmark or combination bookmark, you can quickly display reports and combination reports without selecting each Agent individually.

The information in a combination bookmark is not limited to registered reports. You can also save reports of a specified time period as the base values. These reports that are used to analyze the registered reports are called baselines. By defining and managing multiple registered reports and baselines in a combination bookmark, you can display them on the same graph as a combination report. Such combination reports allow you to ascertain the operating status of the system as a whole.

The following figure shows the relationship between the definition of a combination bookmark and a combination report.
By creating a combination bookmark that contains report definitions for more than one Agent, you can display multiple reports in one graph. For example, you can see the figure above to check the correlation between number of transactions handled by the HTTP service and its response time by superimposing the two values in a combination report.

For more information about displaying combination reports, see Tuning Manager User Guide.

Displaying a report

If you start Performance Reporter by selecting an Agent in the main window of the Tuning Manager server, you can select a report in the report tree selection window displayed for the Agent. Therefore, you can skip steps 1 to 3.

To display a report:
1. In the navigation pane, choose the Agents link.
   The Agent tree displays.
2. In the Navigation frame, select the desired Agent from the Agent tree.
3. In the method pane, choose Display Reports.
   The report tree for the selected Agent displays.
4. From the report tree, select the report to display (see the following figure).
   The report is displayed in the report window.
Checking data model versions

You can check data model versions by performing either of the following procedures.

To check the data model version specified in a report:

In a report window, click the Properties link. The Agent type and data model version is displayed in Product in the Name and type area.

To check the data model version of an Agent:

1. In the agents tree, select the Agent whose report you want to display.
2. In the method pane, click Display properties.

   The service properties window is displayed. The data model version is displayed at the bottom of the information pane.

For some solution set reports, the data model version enclosed in parentheses might be added to the end of the report name. Solution set reports whose names do not include data model versions can be used regardless of their data model version because they do not depend on Agent data model versions.
Acquiring data from Agents and Device Manager

This chapter describes the functions for acquiring data from Agents and Device Manager (referred to hereafter as polling) and how to specify the settings for data acquisition. You must log in as a user who has the Admin permission when specifying the settings for data acquisition. For more information, see Tuning Manager Server Administration Guide.

This chapter contains the following topics:

- Using a Tuning Manager server to acquire data (polling)
- Data collected from an information source
- Information resources for the monitoring host
- Monitoring Agentless hosts
- Configuring the polling settings
- Checking the polling settings
- Editing the polling settings
- Data retention periods
Using a Tuning Manager server to acquire data (polling)

A Tuning Manager server collects data from Agents and Device Manager, and stores it in the Tuning Manager server database. This function is called polling.

Polling can be performed automatically by specifying a polling schedule or manually at a desired point of time. When polling is performed, a series of operations are performed, such as aggregating collected data, deleting data that is older than the data retention periods from the database, and then issuing system alerts.

This section describes data that is collected from Agents or Device Manager when polling is performed. In this manual, Agents and Device Manager for which polling is performed are called information sources.

Data collected from an information source

When polling is performed, data stored in an information source is collected and then stored in the Tuning Manager server database. The system configuration data and capacity data is collected when polling is performed.

The following notes apply to polling:

- A storage system from which data is collected must be monitored by an Agent and managed by Device Manager.
- Performance information is not collected during polling. It is collected from Agents when the performance information report is displayed.
- The Tuning Manager server monitors all the virtualization servers that are configured in Device Manager except for those that are manually registered from the Device Manager GUI or CLI. To check information about virtualization servers, display the host list in the host management window of Device Manager. Note that the Tuning Manager server can only monitor the virtualization servers that are configured in Device Manager. It is not possible to add, or remove virtualization servers as monitoring targets on the Tuning Manager server side.
- When you set the polling schedule or perform manual polling of Tuning Manager server, make sure that the connection target Device Manager has completely collected the data. If you perform polling when Device Manager is collecting the data, polling of Tuning Manager server may fail.
- The Tuning Manager server cannot display information about a datastore in a virtualization environment that has been created on NFS connected via an IP network, because Device Manager is unable to acquire information about it.
- Capacity information for a hypervisor is displayed only when the datastore type is Datastore (VMFS).
- To monitor capacity information of datastores on free VMware ESXi, you must have a valid VMware license.
- To acquire mapping information for a file system of a guest OS and a logical device, configure the settings for accessing the logical device from the guest OS via a path through the connection of RAW Device
Mapping of VMware and Hyper V. For more information about the settings, refer to the administration software documentation for each virtualization environment.

- If the Tuning Manager server software collects information for monitoring hosts from Device Manager, the Tuning Manager server software operating as a stand-alone program cannot add or remove specific hosts as monitored hosts.

The following table lists information sources from which data about system configuration and data capacity is collected. The table also lists resources monitored by each information source.

**Table 3-1 Relationships between information sources and monitored resources**

<table>
<thead>
<tr>
<th>Monitored resource</th>
<th>Information source for configuration information</th>
<th>Information source for capacity information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage system</td>
<td>CLPR or SLPR Agent for RAID</td>
<td>Agent for RAID</td>
</tr>
<tr>
<td>Processor</td>
<td>Agent for RAID</td>
<td>None</td>
</tr>
<tr>
<td>Dynamic Provisioning pool and Dynamic Provisioning volume</td>
<td>Device Manager</td>
<td>Agent for RAID</td>
</tr>
<tr>
<td>Other</td>
<td>Device Manager</td>
<td>Device Manager</td>
</tr>
<tr>
<td>Hypervisor</td>
<td>Virtualization environment Device Manager</td>
<td>Device Manager</td>
</tr>
<tr>
<td>Host (Agent mode)*</td>
<td>OS Agent for Platform</td>
<td>Agent for Platform</td>
</tr>
<tr>
<td>File system</td>
<td>Device file Agent for RAID Map</td>
<td>Agent for Platform</td>
</tr>
<tr>
<td>Host (Agentless mode)*</td>
<td>OS Device Manager</td>
<td>None</td>
</tr>
<tr>
<td>File system</td>
<td>Device file Device Manager</td>
<td>None</td>
</tr>
<tr>
<td>Device file</td>
<td>Agent for SAN Switch</td>
<td>None</td>
</tr>
<tr>
<td>Application</td>
<td>Oracle Agent for Oracle</td>
<td>Agent for Oracle</td>
</tr>
<tr>
<td>NAS and others</td>
<td>Other Agents</td>
<td>Other Agents</td>
</tr>
</tbody>
</table>

* If the monitoring resource is a host, you can select an information source from the following: (a) Agent for Raid Map and Agent for Platform or (b) Device Manager.

For details, see [Selecting a host’s information source (Agentless host mode)](on page 3-4).
Information resources for the monitoring host

The mode in which information is obtained from Agent for Raid Map and Agent for Platform is called *Agent mode*. The mode in which information is obtained from Device Manager is called *Agentless mode*. A host that is managed by Tuning Manager server in the Agentless mode is called an *Agentless host*. A host that is managed by Tuning Manager server in the Agent mode is called an *Agent host*.

When you monitor hosts using Tuning Manager server, you can select an information resource from the following options:

- Agent mode: Agent for RAID Map and Agent for Platform
- Agentless mode: Device Manager

Agent mode takes effect when both the following conditions are met:

- Agent for RAID Map and Agent for Platform have been set up.
- Agent for RAID Map and Agent for Platform are running and recognized by Collection Manager.

Selecting a host's information source (Agentless host mode)

The following table describes the differences between using Agent for RAID Map and Agent for Platform, or Device Manager as a monitoring host.

<table>
<thead>
<tr>
<th>Host monitoring mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| Agent                | - The information resources used for the Agent mode are Agent for RAID Map and Agent for Platform.  
                        - Configuration, performance, and capacity information is acquired.  
                        - Agent for RAID Map and Agent for Platform must be installed on each host.  
                        - The relationship between hosts and storage system is more apparent.  
                        - Performance information of hosts and capacity information trends can be tracked, and alarms can be set. |
Acquiring data from Agents and Device Manager

3–5

Hitachi Tuning Manager Getting Started Guide

Required conditions for enabling each host monitoring mode

The following conditions are required for enabling the Agent mode or Agentless mode:

- **Agent mode**
  Both Agent for RAID Map and Agent for Platform have been set up on each host.

- **Agentless mode**
  Information from each Agentless host has been refreshed. For details, see Monitoring Agentless hosts on page 3-7.

**Note:** If the conditions for enabling Agent mode and Agentless mode are both satisfied, the monitoring mode is set to Agent mode. When an alias name is set to a host, both Agent mode and Agentless mode are applied. As a result, Tuning Manager server GUI displays both the host’s real name and its alias name as the monitoring target host. To ensure that only the alias name of the host is used for Tuning Manager reports, you must disable Agentless mode.

For details about disabling Agentless mode, see the Tuning Manager Server Administration Guide.

Switching monitoring mode

After operation starts, you can switch to Agent mode or Agentless mode. For details, see Monitoring Agentless hosts on page 3-7.

Differences in collected information by monitoring mode

Some collected information might differ depending on whether the host is monitored in Agent mode or in Agentless mode. The following table shows cases in which the information that is collected differs by monitoring mode.

<table>
<thead>
<tr>
<th>Host monitoring mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| Agentless            | • The information resources used for the Agentless mode are Device Manager or Device Manager Agent.  
                      |   Note: If the Device Manager Host Data Collector is used, Device Manager Agent is not required.  
                      |   • Information about the configuration of monitored hosts is acquired.  
                      |   • Neither Agent for RAID Map nor Agent for Platform is required to be installed on each host.  
                      |   • Relationships between hosts and storage systems are more apparent. |

**Note:** When you use the AIX VIOS functionality to deploy a VSCSI device on a VIOC-zoned host, the file system associated with the device file of the VSCSI device is displayed in Agent mode, but not in Agentless mode.
<table>
<thead>
<tr>
<th>Cases in which different information is collected in each monitoring mode</th>
<th>Information that is collected for</th>
<th>Display specification for Agentless monitoring mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Agent monitoring mode</td>
<td>Agentless monitoring mode</td>
</tr>
<tr>
<td>Creating a file system on a logical volume created using VERITAS Volume Manager (VxVM) on a Solaris host</td>
<td>• For Tuning Manager Agents v5.9 and later: The relationship with the device files comprising the logical volume under the corresponding file system is collected as the relationship between the file system and device files. • For Tuning Manager Agents earlier than v5.9: The relationship with the device files comprising the drive group under the corresponding file system is collected as the relationship between the file system and device files.</td>
<td>The relationship with the device files comprising the drive group under the corresponding file system is collected as the relationship between the file system and device files. For host monitoring by Hitachi Command Suite Agent:</td>
</tr>
<tr>
<td>Collecting device file names on a Solaris host</td>
<td>The device file name is the instance name (kernel compression name).</td>
<td>For host monitoring by Host Data Collector: The device file name is the instance name (kernel compression name). For host monitoring by Hitachi Command Suite Agent: The device file name is the logical drive device name.</td>
</tr>
<tr>
<td>Collecting device files</td>
<td>The following types of information are collected and treated as resources: • Local drives • LUs</td>
<td>The following types of information are collected and treated as resources • LUs Local drive information cannot be collected.</td>
</tr>
</tbody>
</table>

Table 3-3 Differences in collected information by monitoring mode
Monitoring Agentless hosts

The addition and deletion of monitoring targets is determined by Agent for RAID Map, Agent for Platform, and Device Manager monitoring status. A host can be switched between Agent mode and Agentless mode. Host information is automatically carried over when this happens. The polling history and schedule information are not carried over.

Note: Polling history indicates whether host information was successfully obtained during the previous polling. Schedule information refers to the times set for each Agent to perform polling.

Agent hosts and Agentless hosts can both exist within the same system. Because there is relatively no difference between the OS type of a storage management server running Tuning Manager server and Device Manager server and the OS type of a host that can be monitored by using Tuning Manager server and Device Manager server, hosts of any platform can be monitored.

The following topics describe how to add, delete, and refresh monitoring of Agentless hosts from Device Manager GUI. For information about administering Device Manager, see Hitachi Command Suite Administrator Guide.

Adding an Agentless host as a monitoring target

Because the Tuning Manager obtains information about Agentless hosts from all Hitachi Command Suite instances, once discovery is performed in Hitachi Command Suite, only Tuning Manager Main Console polling is needed. However, to display the relationship between Agentless hosts and storage resources, you first need to add the agentless hosts to discover Agentless hosts and storage systems in Hitachi Command Suite.

Adding an agentless host

1. Register with Hitachi Command Suite any storage systems related to the monitored host.
2. Perform discovery in the Hitachi Command Suite GUI or CLI, and register the monitored host.
3. Perform Tuning Manager Main Console manual polling.

   In the Tuning Manager Main Console Data Polling window, make sure that Hitachi Command Suite is a polling target, and perform manual polling.
4. Make sure that the monitored hosts are displayed in the Tuning Manager Main Console window under **Hosts** in the Tuning Manager Main Console navigation tree, make sure that the host added as a monitoring target is displayed.

**Note:** The Tuning Manager server cannot monitor any hosts that are manually registered in Device Manager from the Device Manager GUI or CLI. To check the host information, display the host list in the host management window of Device Manager.

If the Agentless host cannot be added with the above procedures, an incompatibility with the Hitachi Command Suite specification exists.

**Refreshing Agentless host information**

You should periodically refresh the Agentless host information.

**To refresh agentless host information**

1. Refresh any storage systems related to the monitored host, in Hitachi Command Suite.
   
   Use the Hitachi Command Suite GUI or CLI to perform a refresh operation, and then update the information about storage systems related to the monitored host.

2. Refresh the host in Hitachi Command Suite.
   
   Perform a refresh operation by using the Hitachi Command Suite GUI or CLI, and update information about monitored hosts.

3. Perform Tuning Manager server manual polling.
   
   In the Tuning Manager server Data Polling window, make sure that Hitachi Command Suite is a polling target, and perform manual polling.

4. Make sure that the monitored host is displayed in the Tuning Manager Main Console window.
   
   Under **Hosts** in the Tuning Manager Main Console navigation tree, make sure that the refreshed host is displayed.

**Updating configuration information**

Before performing troubleshooting using Hitachi Command Suite for a production system, or to change the configuration of a host that is being monitored in Agentless mode, update the configuration information retained by Device Manager and Tuning Manager server as follows.

1. Refresh the host and storage system for which troubleshooting or configuration changes are to be performed.

2. In the Tuning Manager Main Console Data Polling window, make sure that Device Manager is a polling target, and perform manual polling.

3. Under **Hosts** in the Tuning Manager Main Console navigation tree, make sure that the corresponding host is displayed.
Determining the current monitoring mode

Use the `jpcctrl list` command to check whether a host Agent exists on the host for which the monitoring mode is to be determined.

If the return from the `jpcctrl list` command shows that a host Agent exists, the monitoring mode for the host is Agent mode, otherwise the monitoring mode is Agentless mode.

Switching the host monitoring mode from Agent to Agentless

When the host monitoring mode is switched from Agent mode to Agentless mode, a host Agent needs to be removed from the host to be switched. The previous configuration information and capacity information collected and stored in the database by the Tuning Manager server will be carried over after the switch is completed. However, past collected performance information that is displayed on demand for the reports obtained from the Agent, and past capacity information collected and stored in the Tuning Manager database will no longer be accessible after the host Agent is removed.

To switch the host monitoring mode from Agent to Agentless:

1. Back up the instance of the host Agent installed on the corresponding host, before removing the agent.
2. On the Tuning Manager server, delete the configuration information related to the host Agent on the corresponding host.
   a. To delete the service information, use the `jpcctrl delete` command. For details about the `jpcctrl delete` command, see the Tuning Manager CLI Reference Guide.
   b. Restart Collection Manager to complete the deletion of the service information.
   c. Restart Performance Reporter.
3. Add the corresponding host as a Tuning Manager monitoring target.
4. Refresh the agent information in the Tuning Manager Main Console Data Polling window, and make sure that the host Agent for the corresponding host is displayed in the list.

Switching the host monitoring mode from Agentless to Agent

To switch the host monitoring mode from Agentless mode to Agent mode, use the following procedure.

1. Install a host Agent on the host for which the monitoring mode is to be switched, and add it as a Tuning Manager monitoring target.
2. In the Tuning Manager Main Console Data Polling window, refresh the Agent information.

Note: The corresponding host does not need to be deleted from Device Manager. The host can be deleted only when it is no longer needed as a Device Manager management target.
3. Make sure that the instance of the host Agent for the corresponding host is displayed in the list, then set the corresponding host Agent as a polling target.


5. Under **Hosts** in the Tuning Manager Main Console navigation tree, make sure that the corresponding host is displayed.

**Deleting an Agentless host as a Tuning Manager monitoring target**

This topic describes how to delete an Agentless host from the Hitachi Command Suite management target list and the Tuning Manager server.

**To delete an Agentless host**

1. Delete the monitored Agentless host from the Hitachi Command Suite management target list.
   
   Perform the deletion operation from the Hitachi Command Suite GUI or CLI, and delete the monitored host from the Hitachi Command Suite management target list.

2. Perform Tuning Manager server manual polling.
   
   In the Tuning Manager server Data Polling window, make sure that Hitachi Command Suite is a polling target, and perform manual polling.

3. Make sure that the deleted host is not displayed in the Tuning Manager server Main Console window.
   
   Under **Hosts** in the Tuning Manager Main Console navigation tree, make sure that the host deleted from the Hitachi Command Suite management target list is not displayed.

**Configuring the polling settings**

In a Tuning Manager server, you can specify the following polling settings:

**Polling schedule**

A Tuning Manager server performs polling according to a set schedule, and collects hourly data from the data retained in information sources. Polling processing involves the collection of resource data collected by information sources after the last time polling processing was performed. The Tuning Manager server collects data from the information sources and performs time-axis aggregation for the collected capacity information. We recommend that you perform polling once a day (at 0:00).

If Daylight Saving Time is in effect, the values for all check boxes are treated as Daylight Saving Time values.

**Backdate offset periods**

Even if the polling schedule has been set, polling of Agents might fail. Possible causes are as follows:

- The Agents to be polled have stopped.
• Communication with the Agents to be polled has failed.

In either of these cases, by setting a backdate offset period, you can specify that the data that could not be acquired from the Agents be acquired during the next polling.

For example, assume that the polling schedule has been set to perform polling every hour on the hour, and that polling failed during the period from 12:00 to 16:00. In this case, you need to specify 4 hours for the backdate offset period to collect the past data that you failed to collect. By specifying 4 hours for the backdate offset period, the polling at 17:00 acquires not only the data for 17:00, but also the data not acquired at 13:00, 14:00, 15:00, and 16:00.

The point at which data acquisition starts the next polling is dependent on whichever of the following times is nearer the current system time:

- \( \text{current-record-time} + 1 \text{ hour} \)
- \( \text{current-record-time} - \text{backdate-offset-period} \)

For example, if the current time is 1 pm, the backdate offset value is 2 hours, and the most recent record was collected at 12 pm, the value of when the most recent record was collected plus 1 hour(1 pm) is used for the start time.

---

**Note:** Specify an appropriate time at which polling processing is performed in the polling schedule so that the polling interval is equal to or shorter than the backdate offset period.

The backdate offset period must be equal to or shorter than the data retention period. If you set a backdate offset value that is longer than the data retention period, the backdate offset value will automatically become the same as the data retention period.

---

**Setting polling retry options**

A Tuning Manager server can retry polling when an initial polling attempt for an Agent fails. You can specify the retry interval and the number of retries. By default, polling is not retried. Although the Tuning Manager server can retry polling when a polling attempt for an Agent fails, use the default setting unless the Technical Support Center recommends otherwise.

When specifying the retry interval and the number of retries, you need to consider a polling schedule and time it takes to complete polling. For example, if polling is set to be performed 4 times a day (every 6 hours) and single polling takes 15 minutes to complete, the retry interval and the number of retries must satisfy the following equation:

\[ 15 \text{ minutes} + (\text{retry-interval} + 15 \text{ minutes}) \times \text{number-of-retries} \leq 6 \text{ hours} \]

If you want to change the polling schedule, you need to estimate the time to complete the new polling, and then decide the appropriate retry interval and number of retries.

If a subsequent polling start time occurs during a retry attempt, that polling is not performed.
Checking the polling settings

To check the polling settings:
1. Click *Administration* in the explorer area.
2. Click *Data Polling* in the submenu.

The Data Polling window appears. The following tables describe the contents of each column in the Data Polling window.

Table 3-4 Information displayed in the window for checking the polling settings

<table>
<thead>
<tr>
<th>Displayed information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Polling Settings</strong></td>
<td><strong>Default Polling Schedule</strong></td>
</tr>
<tr>
<td><strong>Backdate Offset</strong></td>
<td>Indicates how far the polling processing goes back to acquire past data. The unit is hour(s). If this value is 0, the polling processing does not acquire past data. The default is 24.</td>
</tr>
<tr>
<td><strong>Retry Settings</strong></td>
<td>Indicates the settings about retries when polling processing fails. The retry interval and the number of retries are displayed. If the retry interval is 0, a retry occurs immediately after polling processing fails. If the number of retries is 0, no retry occurs. If the retry setting is not specified, <strong>Disabled</strong> is displayed.</td>
</tr>
</tbody>
</table>
### Displayed information

<table>
<thead>
<tr>
<th>Agents</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Indicates the service ID of the Agent (Agent for SAN Switch, Agent for Oracle, or Agent for RAID Map) or HDvM.¹</td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Indicates the type of the Agent or Device Manager.¹</td>
</tr>
<tr>
<td></td>
<td>Polling Schedule</td>
<td>Indicates the polling schedule for each Agent. The specified polling times are displayed with each polling time separated by a comma (,). If the default setting is used, Default is displayed. If the settings specify that polling is not to be performed, nothing is displayed.</td>
</tr>
<tr>
<td></td>
<td>Last Polling Time</td>
<td>Indicates the time at which the last polling processing was performed. If no polling processing has been performed or Status is Available, n/a is displayed.</td>
</tr>
<tr>
<td></td>
<td>Related Agent</td>
<td>The related Agent is displayed.¹</td>
</tr>
</tbody>
</table>

#### Note 1:

The displayed items vary depending on the combination of Agents. The following table lists the displayed items.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Related Agent</th>
<th>Monitoring targets</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDvM</td>
<td>HDvM</td>
<td>Service ID of Agent for RAID</td>
<td>Storage system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blank</td>
<td>Host (Agentless mode)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Hypervisor</td>
</tr>
<tr>
<td>Service ID of Agent for RAID Map</td>
<td>If Agent for Platform is for Windows, Windows is displayed. Otherwise, Unix is displayed.</td>
<td>Service ID of Agent for Platform</td>
<td>Host (Agentless mode)</td>
</tr>
<tr>
<td>Service ID of Agent for SAN Switch</td>
<td>Switch</td>
<td>Blank</td>
<td>Switch</td>
</tr>
<tr>
<td>Service ID of Agent for Oracle</td>
<td>Oracle</td>
<td>Blank</td>
<td>Oracle</td>
</tr>
</tbody>
</table>

3. If you want to check the current information in the Data Polling window, click Refresh.

The Data Polling window is refreshed to display the current information.
While the Tuning Manager server is polling, the system is unable to obtain the latest Agent information. During this time, the Tuning Manager server displays a message that indicates that the Tuning Manager server is currently polling in the message area.

**Note:** You can estimate how long polling will typically require by examining the system log.

### Editing the polling settings

You can edit the polling settings at one time by using a window for editing the polling settings. This section describes how to edit the polling settings.

For details on the valid values for entries, see the *Server Administration Guide*.

To edit the polling settings:

1. Click **Administration** in the explorer area.
2. Click **Data Polling** in the submenu.
   The Data Polling window appears.
3. Click **Edit General Polling Setting**.
   The Edit Polling Settings dialog box appears.
4. In **Default Polling Schedule**, select the check boxes in the table.
   o To select all the check boxes:
     Click **Select All**.
   o To clear all the check boxes:
     Click **Deselect All**.
     If you clear all the check boxes, polling is not performed.
   o To select the check boxes for odd hours:
     Click **Select Odd Hours**.
   o To select the check boxes for even hours:
     Click **Select Even Hours**.
5. Enter a value in **Data Backdate Offset** of **Edit Polling Schedule**.

**Note:** For **Default Polling Schedule**, specify an appropriate time at which to perform polling so that the polling interval is equal to or shorter than the value specified for Data Backdate Offset.

Example:
If you specify the following settings, change the settings so that polling processing is performed once between 11:00 and 14:00 because data processed from 5:00 to 10:00 cannot be collected.

Polling times specified in **Default Polling Schedule**: 5:00 and 20:00
Period specified for **Edit Polling Schedule**: 9 hours
6. In **Polling Retry Settings**, enter the retry interval and the number of retries.

   **Note:** Although the Tuning Manager server can retry polling when a polling attempt for an Agent fails, use the default setting unless the Technical Support Center asks.

7. Click **OK** to save the settings. (Click **Cancel** to discard the changes.)

   Polling is usually performed by following the default polling schedule. However, you can specify the polling schedule for each information source.

   To specify a time to perform polling by information source:
   1. Click **Administration** in the explorer area.
   2. Click **Data Polling** in the submenu.
      The Data Polling window appears.
   3. Select the check box of the information source for which you want to specify the schedule, and then click **Edit Polling Schedule**.
      The Edit Polling Schedule window appears.
   4. Select the **Specify polling schedule** radio button, and then select the check boxes in the table.
      - To select all the check boxes:
        Click **Select All**.
      - To clear all the check boxes:
        Click **Deselect All**.
        If you clear all the check boxes, polling is not performed.
      - To select the check boxes for odd hours:
        Click **Select Odd Hours**.
      - To select the check boxes for even hours:
        Click **Select Even Hours**.
   5. Click **OK** to save the settings. (Click **Cancel** to discard the changes.)

**Data retention periods**

A Tuning Manager server allows you to set the retention periods of configuration and capacity information stored in the database. Data which is older than the retention period is automatically deleted from the database.

To conserve resources and maximize the performance of the Tuning Manager server, we recommend that you set the data retention periods according to your system environment. For example, if polling is interrupted due to insufficient free capacity in the database, you can shorten the data retention period to lower the database usage rate.

You can also lower database utilization by increasing the total database capacity.
For details on how to increase the total database capacity, see the *Server Administration Guide*.

**Checking the data retention period settings**

To check the retention periods of configuration and capacity information in the Tuning Manager server database:

1. Click **Administration** in the explorer area.
2. Click **Data Retention** in the submenu.

A window for checking the data retention periods appears. The following table describes the contents of each column in the window.

**Table 3-5 Information displayed in the window for checking the settings for data retention periods**

<table>
<thead>
<tr>
<th>Displayed information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Metrics data</strong></td>
<td></td>
</tr>
<tr>
<td>Hourly</td>
<td>Indicates the period of time that hourly data is to be retained.</td>
</tr>
<tr>
<td>Daily</td>
<td>Indicates the period of time that daily data is to be retained.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Indicates the period of time that weekly data is to be retained.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Indicates the period of time that monthly data is to be retained.</td>
</tr>
<tr>
<td>Yearly</td>
<td>Indicates the period of time that yearly data is to be retained.</td>
</tr>
<tr>
<td><strong>Configuration History</strong></td>
<td></td>
</tr>
<tr>
<td>Host Configuration</td>
<td>Indicates the period of time that the host and hypervisor configuration history is to be retained.</td>
</tr>
<tr>
<td>Array Configuration</td>
<td>Indicates the period of time that the device configuration history is to be retained.</td>
</tr>
<tr>
<td>Fabric Configuration</td>
<td>Indicates the period of time that the fabric configuration history is to be retained.</td>
</tr>
<tr>
<td>Application Configuration</td>
<td>Indicates the period of time that the application configuration history is to be retained.</td>
</tr>
<tr>
<td><strong>System Reports</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Indicates the period of time that the polling execution result is to be retained.</td>
</tr>
</tbody>
</table>

**Editing the data retention periods**

This section describes how to edit the retention periods for configuration and capacity information in the Tuning Manager server database.

For details on the valid values for entries, see the *Server Administration Guide*.

To edit the retention periods:
1. Click **Administration** in the explorer area.
2. Click **Data Retention** in the submenu.
   A window for checking the data retention periods appears.
3. Click **Edit Data Retention Settings**.
   A dialog box for editing the data retention periods appears.
4. In **Metrics data**, specify the period of time that the capacity data of resources is to be retained.
   - **Hourly**
     Specify a value in the field and select the unit of time. The default is 7 days.
   - **Daily**
     Specify a value in the field and select the unit of time. The default is 3 months.
   - **Weekly**
     Specify a value in the field and select the unit of time. The default is 3 months.
   - **Monthly**
     Specify a value in the field and select the unit of time. The default is 2 years.
   - **Yearly**
     Specify a value in the field. The unit of time is years. The default is 5 years.
5. In **Configuration History**, specify the period of time that the configuration history is to be retained.
   - **Host Configuration**
     Specify a value in the field and select the unit of time. The default is 1 year.
   - **Array Configuration**
     Specify a value in the field and select the unit of time. The default is 1 year.
   - **Fabric Configuration**
     Specify a value in the field and select the unit of time. The default is 1 year.
   - **Application Configuration**
     Specify a value in the field and select the unit of time. The default is 1 year.
6. In **System Reports**, specify the period of time that the polling result is to be retained.
   Specify a value in the field and select the unit of time. The default is 3 months.
7. To save the settings, click **OK**. To discard the settings, click **Cancel**.
8. To delete data that is older than the new data retention periods that you have set, click the **Refresh** button in the Data Polling window. Information in the Data Polling window is updated, and the Tuning Manager server deletes the data that is older than the data retention periods.
Using alarms to monitor operations

With Tuning Manager series programs, you can set threshold values for performance data collection and receive notification if an item exceeds a specified threshold value.

This chapter describes how to use the GUI to set up alarms and use alarms. For details on working with alarms, see the Tuning Manager User Guide. For details on how to use commands to accomplish these tasks, see the Tuning Manager Agent Administration Guide.

This chapter includes the following topics:

- Overview of alarms
- Methods for setting and using alarms
- Planning system monitoring
- Example of prerequisites for setting alarms
- Descriptions of settings when defining an alarm
- Example of creating an alarm table and alarm
- Examples of email notifications
- Monitoring Agents using Performance Reporter
- Monitoring Events using Performance Reporter
Overview of alarms

You can configure the Tuning Manager series to notify you when the performance data monitored by an Agent reaches a preset threshold. This function is used to issue an alarm regarding performance information.

The entity that defines the system action to be performed when a data item reaches a specified threshold is called an alarm, and all the alarms defined as a single set constitute an alarm table. The alarm table for each Agent is located in the Agent program folder. In the navigation pane of the Performance Reporter, click the Alarms link to display the Agent program folders in the Alarms tree.

When a data item reaches a threshold, the Agent issues an alarm event. The operation that the Tuning Manager series program performs when it receives an alarm event is called an action. The following actions are performed by Tuning Manager series programs:

- Send an email to personnel, such as a system administrator.
- Execute a recovery program or other command.
- Sending an SNMP trap

Associating an alarm table with an Agent lets the Tuning Manager server detect when specified thresholds are exceeded. Associating an alarm table with an Agent is called binding. Each agent can have only one alarm table bound to it. However, you can bind the same alarm to multiple Agents.

Methods for setting and using alarms

You can set an alarm in the following ways:

- Define a new alarm table and alarms.
  You can create a new alarm table for your system environment, and then define the alarms. Later, you can add new alarms to the table at anytime.

- Using an existing alarm table or alarms:
  - Use a solution set
    A solution set is a set of alarms that is included with an Agent for which necessary information has been preset. When you use a solution set, the alarms that are specified to be active in the solution set are enabled when the Agent starts.
  - Customize a solution set
    You can copy the solution set and then customize it to suit your system environment.
  - Customize an existing alarm table or alarms
    You can copy an existing alarm table or alarm and then customize it to suit your requirement.
To use alarms, you must associate (bind) an alarm table defined by one of the above methods to the applicable Agents.

**Note:** If you use Internet Explorer to perform operations for the Alarms window of Performance Reporter, do not use the mouse wheel to select an item from the drop-down list. If you use the wheel to scroll the drop-down list, an error (KAVJS0037-E) might occur. If this error occurs, retry the operation without using the mouse wheel to select the listed item.

For information about setting and using alarms by using CLI commands, see the Tuning Manager Agent Administration Guide or Tuning Manager CLI Reference Guide

**Task flow for setting and operating alarms**

The following figure shows the process flow for setting and operating alarms.
Planning system monitoring

This section describes how to use Performance Reporter for system monitoring. The figure below shows the workflow when planning system monitoring with Performance Reporter. For more information on how to

Figure 4-1 Task flow for setting and operating alarms
launch Performance Reporter, see *Launching Performance Reporter on page 2-8*. For more information on planning system monitoring, see *Tuning Manager User Guide*. 

**Example of prerequisites for setting alarms**

Before creating an alarm, you must define system actions that occur at the time of an alarm event. An Agent can perform three types of alarm actions:

- Send an email message
- Send an SNMP trap
- Set up the host to run a recovery program or other commands

You set up these actions in the Performance Reporter window by changing the **Action Handler** and **Trap Generator** properties. Later, when you create an alarm, you define the settings for each action in the New Alarm Table > Actions window.

**Example of setting up email alerts for an alarm**

If you want an Agent to report a problem by sending an email message, you must activate at least one Action Handler service. Then when you create the alarm, you can select the Action Handler service to send email messages.
In this procedure, you set the subject of the email message, but the body of the email message is set when you create the alarm.

**To activate the Action Handler service to enable email notification**

1. Log in to the Tuning Manager GUI with Admin permission.
2. In the Main Console window, in the global menu bar area, select **Go > Performance Reporter**.
3. Click **Services**.
4. Expand **Machines > MgmtServer1** and select **PH1MgmtServer1**.
   - **Machines**: The hosts that are installed with the Tuning Manager series programs and the Agents that are installed on each host.
   - **MgmtServer1**: The host folder.
   - **PH1MgmtServer1**: The Action Handler.
     The name of the Action Handler service begins with **PH**. The icon contains an “A,” which stands for Agent, shown in the following example:

   ![PH1scsa72254]

5. Click **Properties**
6. Click **Capabilities**.
7. To enable email, in **Email**, select **Yes**.
8. Click **OK**.

![Figure 4-3 Enable email](image)
9. To set the email properties, return to Service Properties and click Mail.

10. In this example, the properties are set as follows:
   - **SMTP Host**: 172.17.69.29
   - **Mail Subject**: %SCS: %PTS %AIS on %HNS is the subject of the email, which is determined by the following variables:
     - **%SCS**: The alarm status, which is OK, WARNING, or EXCEPTION
     - **%PTS**: The product name
     - **%AIS on %HNS**: The alarm name and the host name of the agent that binds the alarm table
   - **Protocol**: IPv4

11. Click OK.

**Example email message**

In this example of an email message, the alarm was defined to monitor RAID Group usage. A warning is issued when the usage reaches 40% and an Abnormal alarm is issued when the usage exceeds 70%.
The subject line is set in Step 10 of the previous procedure. In this example, the subject text is Mail Subject: %SCS: %PTS %AIS on %HNS.

1. %SCS: The alarm status, which is EXCEPTION (a critical alarm)
2. %PTS: The product name, which is RAID
3. %AIS: The alarm name, which is LDEV Response Time
4. on %HNS: The host name of the agent that binds the alarm table, which is MgmtServer1

For information about how the message text is set, see the Tuning Manager User Guide.

Related topics
- Before creating the alarm table, you might want to also set up these actions for reporting a problem:
  - Example of setting up an SNMP trap destination on page 4-8
  - Example of setting up the host to run commands on page 4-11
- For more information about setting alarm prerequisites, a list of variables that can be used in the subject line or message text, and the steps to create an alarm table, see the Tuning Manager User Guide.

Example of setting up an SNMP trap destination

If you want an Agent to report a problem by sending an SNMP trap at the time of an alarm event, you must configure the trap destination in the Trap Generator service on a Tuning Manager server. An SNMP trap (message) is defined for each alarm and sent for each alarm event.

The SNMP trap destination is the host name or IP address of the server that receives the trap. Each alarm sends trap messages. Sometimes the SNMP trap destination is called a trap target or trap recipient.

To specify settings for sending an SNMP trap
1. Log in to the Tuning Manager GUI with Admin permission.
2. In the Main Console window, in the global menu bar area, select **Go > Performance Reporter**.
3. Click the **Services** link.
4. Expand **Collection Manager** and select **PCSMgmtServer1**.
   - **Collection Manager**: The services that are provided by Collection Manager. The name of each service is represented by its service ID.
   - **PCSMgmtServer1**: The Trap Generator service on the host that will send the trap. The name of the Trap Generator service begins with “PC.” The icon contains a “T,” which stands for trap, shown in the following figure.

5. Click **Properties**.
6. Select **ADD OR DELETE A TRAP DESTINATION**.
7. In **ADD A DESTINATION**, type **10.68.224.23**.
   - **ADD A DESTINATION**: The host name or IP address of the destination to which the SNMP trap is sent. The name can be a maximum of 75 bytes of alphanumeric characters and hyphens.
8. Click **OK**.
   The trap destination setting for the specified host is added.

![Figure 4-6 Add a trap destination](image)

9. To set the properties for the trap, return to **Service Properties** and click **Trap Destinations**. Type the IP address, 10.68.224.23.
10. Specify the values of the properties as follows:
   - **Retry Count**: 5
     The number of retries. You can specify an integer in the range from 0 to 32,767.
   - **Retry Interval**: 5
The interval between retries (in seconds). You can specify an integer from 1 to 32,767.

**Trap Port: 162**

The port number of the destination. You can specify a number from 1 to 32,767.

**Enabled: Yes**

The setting to enable the destination.

**Protocol: IPv4**

The protocol which is either IPv4 or IPv6.

11. Click **OK**.

---

**Figure 4-7 Set trap properties**

**Related topics**

- Before creating the alarm table, you might want to also set up these actions for reporting a problem:
  - [Example of setting up email alerts for an alarm on page 4-5](#)
  - [Example of setting up the host to run commands on page 4-11](#)
- For information about creating an alarm or alarm table, see the *Tuning Manager User Guide*. 
The Agent that triggers an alarm can be determined from the contents of the Management Information Base (MIB) object in the SNMP trap that is sent by the Tuning Manager server. For details about the MIB object, search for “structure of MIB objects” in the Tuning Manager Agent Administration Guide.

Example of setting up the host to run commands

If you want an Agent to report a problem by running a command at the time of an alarm event, you must set the property of the Action Handler service on the host that will run the commands. The commands (script) are defined when you create the alarm.

To set the property of the Action Handler service to run commands

1. Log in to the Tuning Manager GUI with Admin permission.
2. In the Main Console window, in the global menu bar area, select Go > Performance Reporter.
3. Click Services.
4. Expand Machines > MgmtServer1 and select PHMgmtServer1.
   - Machines: The hosts that are installed with the Tuning Manager series programs and the Agents that are installed on each host.
   - MgmtServer1: The host folder.
   - PH1MgmtServer1: The Action Handler.
     The name of the Action Handler service begins with PH. The icon contains an “A,” which stands for Agent, shown in the following example.

   ![PH1scsa72254]

5. Click Properties.
6. Click Capabilities.
7. In Script, select Yes.
8. Click OK.
When creating an alarm, you must define the type of alarm. These descriptions help you understand how to choose the settings to define the type of alarm you need. Also, the alarm notification is defined when you create the alarm. Some of the variables that are used in an alarm notification are also described.

For more information about these settings, including detailed descriptions, restrictions, and interactions, see the chapter on using alarms to monitor operations, in the Tuning Manager User Guide.

Use the %CVS variable to represent the conditions value in notifications

When defining the message the alarm will send, you use the %CVS variable (also know as measured value) to represent the condition that you are monitoring, as well as other information about the alarm. When the alarm
is triggered, the %CVS value is sent in the email or SNMP message. For example, you might want to monitor the "processor busy rate," which is a condition you can set when defining the alarm. The alarm message you set can be:

**The processor ID %CVS3 on adapter ID %CVS2 reached a busy rate of %CVS1.2.**

The resulting message might be:

The processor ID 00 on adapter ID MPB0 reached a busy rate of 3.05.

More than one %CVS variable can be used to show conditions. See the explanation in the following table.

**Table 4-1 %CVS description**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| %CVS or CVs1, CVs2 | Represents the first condition that is set in the **Alarm Conditions** window when defining an alarm. | In the above example:  
 | %CVS3, etc.        | Represents a second condition.                                              | • The first condition is the processor busy rate, which is %CVS1.2 in the email set up and the value in the email message is “3.05.”  
 |                     | Represents a third condition and so on.                                     | • The second condition is the adapter ID, which is %CVS2 in the email set up and the value in the email message is “MPB0.”  
 |                     |                                                                             | • The third condition is the processor ID, which is %CVS3 in the email set up and the value in the email message is “00.”  

%CVS.1,%CVS.2, CVS2.3, etc.  

Add a decimal point to the %CVS variable to limit the number of decimal places displayed.  

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
|                                                                  | • If no decimal point is added in “CVS,” the value after the decimal can be long, for example 10.357376532652.  
|                                                                  | • If a decimal is added to the %CVS value, the numbers after the decimal point are limited. For example, %CVS.1 limits the value to one decimal point (for example, 10.3), %CVS.2 limits the value to two decimal points (for example, 10.35), and so on.  

The %CVS variable can be used in these notifications:

- The message that is set when creating an alarm in the **General Settings** section. This message is shown in the email body or the SMNP trap message.
- The message subject line that is set in the prerequisite task of configuring an email notification.
Example of a %CVS value used in the message of an alarm email notification or SNMP trap

When creating an alarm, you set up the message in the General Settings section in Alarm message. When the alarm is triggered, the message is sent in an email notification or an SNMP trap with the actual values.

In this example, the key condition that is monitored is “LDEV Response Time.”

- The message that is defined in the General Settings section is:
  Read response time %CVS1.2, LDEV# %CVS2
- This alarm sends a message similar to this:
  Status: Exception
  LDEV Read Response Time 9897.48, LDEV# 00:00:49

At the time the alarm is triggered, the %CVS1.2 variable (first condition) shows the value of the read response time, with the decimal length limited to two digits. The %CVS2 variable (second condition) shows the LDEV number.

Figure 4-9 Set the Alarm message

When creating the alarm, the value is set in the Alarm Conditions window:

- The first alarm condition that is set is Read Response Rate (CVS1.2)
  - Abnormal condition: Read Response Rate > 9000.000
  - Warning condition: Read Response Rate > 8000.000
- The second alarm condition that is set is LDEV Number (CVS2)
  - Abnormal condition: LDEV Number > 0
  - Warning condition: LDEV Number > 0
Example of using %CVS in an email subject of an alarm notification

When setting the email subject, the %CVS variable does not need to be in the email subject, but it can be included to provide the maximum information in the subject. For example, this email subject adds %CVS in the subject line:

Mail Subject: %SCS: %PTS %MTS (%CVS2) on %ANS with value %CVS.1

The resulting subject in an email notification is, for example:

Mail Subject: Exception: DISK_STORAGE Processor is at % busy since 30min (MPB0) on VSP-85013 with value 56.9

The variables in the email subject stand for these values:

- **%SCS**: The alarm status, which is EXCEPTION
- **%PTS**: The product name, which is DISK-STORAGE
- **%MTS**: Message text, which is Processor is at % busy since 30min
- **%ANS**: The Agent name, which is VSP-85013
- **%CVS.1**: First condition specified is the “read response time,” where the value is 56.9
- **%CVS2**: Second condition specified is the “processor number,” where the value is MPB0
Relate the data model version to the RAID product

In the General Settings section, if you are creating a RAID alarm table, you must select a RAID product in the Product section. The choices are the data model versions that relate to the Agent for RAID version. The data model version of the Agent for RAID should be the same as the data model version for the alarm table.

The data model version is the collective name for the records and fields of each Agent. Agents collect various types of performance data from the monitored targets in a record format and then store the data in their Store databases. Each record consists of smaller units called fields. Records and fields are collectively displayed in reports; this is called the data model. For more information about the data model version, see the Tuning Manager User Guide.

In the following example, if the Agent for RAID is 7.5, then choose the data model version that is on the same row in the table. In this example, the data model version is (RAID) 8.4.
Use "Monitor whether a value exists" for critical applications

In the General Settings section, you select Monitor whether the value exists if you want to be notified if a critical application is not running. Normally, you do not select this check box.
Use “Always notify” to receive notifications every time threshold is crossed

In the Advanced settings section, Always notify determines when an alarm is triggered.

- If Always notify is selected, the alarm notification is sent when the alarm conditions are satisfied, whenever the threshold is crossed.
- If Always notify is not selected, the alarm notification is sent when an alarm condition is changed. Therefore, the alarm notification is sent only once when the threshold is crossed, which minimizes the number of notifications.
The following figure shows when the alarm notification is sent:

![Figure 4-15 Differences for “Always notify”](image)

**Always notify** and **Evaluate all data** are interdependent. These settings affect the alarm evaluation. Their relationship is described in tables in the *Tuning Manager User Guide*.

**Use “Evaluate all data” to receive all notifications for multi-row records**

In the **Advanced settings** section, select **Evaluate all data** to evaluate all collected data for multi-row (multi-instance) records.

- Select this check box to receive all notifications of changes in a multi-row record.
- Leave this check box unselected to limit the number of alarms sent. The alarm is issued only once for the first data evaluated for the record that has the worst status.

Records are either single row or multi-row:

- A single-row record is a single-instance record. For example, a single-instance record checks the status of drive A.
- A multi-instance record is one that consists of multiple instances collected at the same time. For example, assume a multi-instance record checks the status of drives A and B. During alarm evaluation, the status of the drives is evaluated for alarms. If either (or both) of the drives meets an alarm condition, an alarm is issued for each drive.
Always notify and Evaluate all data are interdependent. These settings affect the alarm evaluation. Their relationship is described in tables in the Tuning Manager User Guide.

Use “Monitoring time range” to limit notifications to certain time periods

In the Advanced settings section, Monitoring time range specifies the time range during which the collected data is to be monitored. Specify a time range if you want to mask out time periods that might routinely send alarms that are not important. For example, you might have backups during the night that send alarms that do not concern you. Therefore you can limit the time during the day when you are concerned with thresholds.

• If Always notify is checked, collected data is monitored 24 hours a day.
• If you specify a monitoring time range, the collected data is monitored during that time. A Normal alarm is issued at the specified end time. A Normal alarm indicates that the alarm is outside the monitoring time range.

For the End time, the minutes (MM) setting is the specified minute plus 59 seconds. For example, if a range from 9:00 to 21:00 is specified, monitoring starts at 9:00:00 and ends at 21:00:59.
Use “Damping” to limit notifications

In the Advanced settings section, you can set **Damping** to prevent one or a small number of sporadic instances from triggering the alarm.

- **Occurrence**: Specify the number of times a violation of the threshold occurs.
- **Interval**: Specify the number of data collections in which the violations occur before an alarm is sent.

In this example, the alarm is sent when the threshold is violated twice (occurrence) and the occurrences are detected in the last five data collections.
Example of creating an alarm table and alarm

In this example:

- You create the USP VM alarm table and RAID Group alarm.

Note: Available metrics vary by array model. Proper Tuning Manager metrics should be verified for an array model prior to alarm set up.

- The key performance measurement (record) for the alarm is RAID Group Summary PI_RGS, which holds performance data of the parity group. The Field (condition) is Busy %, which is the usage rate of the parity group.

To create an alarm table and an alarm for USP VM RAID

1. Log in to the Tuning Manager GUI with Admin permission.
2. In the Main Console window, in the global menu bar area, select Go > Performance Reporter.
3. Click Alarms.
4. Select the RAID folder. This is the Agent for RAID folder where you will create an alarm table and an alarm.
5. In the Method frame, click New Alarm Table.
6. In General settings, specify the basic information for the alarm.
   a. In Product, select RAID (8.4). This setting matches the version of the Agent for RAID (data model).
      The product name is the value for the %PTS variable.
   b. In Alarm table name, enter USP VM. The name is a maximum of 20 characters and cannot begin with “PFM” (not case-sensitive).
c. In **Alarm name**, enter **RAID Group**.
   The alarm table name is the value for the %ATS variable.

d. In **Alarm message**, enter **%ANS RAID Group %CVS2 Avg Busy = %CVS1. Should be < 50%**. This is the main content that appears in the notification. This content is the %MTS variable that you use later when you set up the email message.
   
   For example, an alarm notification for the above variables could contain this message: **DA1USPVM_53610[MgmtServer1] RAID Group 1-5 Avg Busy = 50.6. Should be < 50%**
   
   Also, if a decimal is added to the %CVS value in the alarm message, the numbers after the decimal point are limited. For example, %CVS.1 limits the value to one decimal point (for example, 10.3), %CVS.2 limits the value to two decimal points (for example, 10.35). If you don’t limit the value with a decimal point the value could be quite long, (for example, 10.357738588901).
   
   For more messages examples, see **Examples of email notifications on page 4-36**.
   
   For more information on variables, see **Use the %CVS variable to represent the conditions value in notifications on page 4-12**.

e. Do not select **Monitor whether the value exists**. This setting is used only to check that critical applications are not running.

For more information on how to set up alarms, refer to the documentation provided.

---

**Figure 4-19 General settings**

7. In **Advance settings**, specify to start the alarm immediately and set more values for the notifications.

   a. Select **Enable alarm** to immediately activate the alarm after it is created.

   b. **Always notify** and **Evaluate all data** are not recommended, because using them could result in an immense number of notifications. Leaving these unselected minimizes the number of notifications.
c. In Monitoring time range, Always monitor is selected by default. Leave this selected to monitor 24 hours a day.

d. In Damping, select Report alarm when the following damping condition is reached. Then specify two occurrences at two intervals.

   The damping settings prevent a small number of sporadic instances from triggering the alarm. The alarm notification is not sent until the threshold is violated twice (occurrences) and the occurrences are detected in the last two data collections (interval).

e. Click Next.

8. Specify the alarm conditions, which are the key metrics that trigger the alarm.

   a. In Record, select the target record for the condition to be measured. For this example, select RAID Group Summary (PI_RGS).

      To see a description of the selected Record and its fields, click the Description button.

   b. In Field, select Busy %, which is the usage rate of the parity group. This setting is the first condition (CVS1 variable) that was set earlier for the email or SNMP notifications.

   c. In Condition, select greater than or equal to (>=).

   d. In Abnormal value, enter the threshold value as 70.

   e. In Warning value, enter the threshold value as 40.

   f. Click Add.

      The first condition is shown.
Using alarms to monitor operations

You can specify multiple conditional expressions, which are combined with AND operators. The alarm is issued when all of the expressions are satisfied.

g. For the second condition, leave the Record setting as is.

h. Change the Field setting to RAID Group Number, which is the parity group number.

i. Leave the Condition setting at >=.

j. In Abnormal value, change the setting to 0.

k. In Warning value, change the setting to 0.

l. Click Add.

The second condition is shown.

m. Click Next.
9. When the alarm is triggered, you can be notified by email or an SNMP trap, or you can set up a command to run automatically. In this example, you’ll set up the email notification.
   
a. In **Actions to be executed**, and for **Email**, select **Abnormal** and **Warning**.
   
b. Click **Next**.
10. Configure the email notification.
   a. In **Email address**, specify `alert_san_admins@otpp.com`. This setting is the email addresses for those who will receive the notifications.
   b. In **Action handler**, leave the default. This setting is the Action Handler service that will use the email notification function. The default Action Handler was set earlier in Example of setting up email alerts for an alarm on page 4-5.
   c. In **Email body**, leave the variables. Or you can add variables to the defaults to include more information in the email notification.
   d. Click **Finish**.
Using alarms to monitor operations

The default variables are:
- Date: %SCT
- Host: %HNS
- Product: %PTS
- Agent: %ANS
- Alarm: %AIS
- Alarm table: %ATS
- State: %SCS
- Message: %MTS

In this example of an email notification, the State is a Warning and the message (%MTS variable) is

**DA1USPVM_53610[MgmtServer1] RAID Group 1-5 Avg Busy = 50.6. Should be < 50%.**

**Figure 4-24 Set email content**

The default variables are: Date: %SCT, Host: %HNS, Product: %PTS, Agent: %ANS, Alarm: %AIS, Alarm table: %ATS, State: %SCS, Message: %MTS

**Figure 4-25 Email example**

For more email examples, see Examples of email notifications on page 4-36.

The new alarm table **USP VM** with the alarm **RAID Group** is shown in the RAID alarm list. At this point, you can add more alarms to the alarm table. Select the alarm table and click **New alarm**. Then follow...
the steps in this procedure, beginning with Step 5. To create more alarms, see Settings for creating more alarms for the USP VM alarm table on page 4-32.

11. Activate the alarm.
   a. Click Alarms.
   b. Select the RAID>USP VM >RAID Group alarm.
   c. Click Activate.
   d. Select the RAID Group alarm.
   e. Click OK.

   The RAID Group alarm is activated.
12. Bind the alarm table to the RAID Agent. This setting enables Performance Reporter to receive alarm events from the Agent.
   a. Click Agents.
   b. Click RAID > DA1USPV_10071[MgmtServer1]. The selected Agent is marked with a check mark.
   c. Click Bind Alarm Table.
   d. Select the RAID > USP VM alarm table.
   e. Click OK.
   The USP VM alarm table is bound to the RAID Agent.

13. Verify that the alarm is running.
a. Click Agents.
b. Select RAID > DA1USPV_10071[MgmtServer1].
c. Click Display Alarm Status.
   A list of the alarms in the alarm table is displayed. In this example, the RAID Group alarm shows a check mark that indicates normal status. Other status indicators are warning or abnormal.

Figure 4-29 Check alarm status

14. To view alarm events, click Event Monitor.

Figure 4-30 View alarm events
   The Event Monitor window appears as a separate window.
Using alarms to monitor operations

## Related topics

- For descriptions of settings, see [Descriptions of settings when defining an alarm on page 4-12](#).
- See the chapter on using alarms in the *Tuning Manager User Guide*.
  - For variable definitions, see the section on variables to use when creating an alarm table.
  - For restrictions and general steps for creating an alarm, see the section on creating alarms.
  - For reference information, see the section on references for creating an alarm.

## Settings for creating more alarms for the USP VM alarm table

The following tables list the key settings for creating several alarms to be included in the USP VM alarm table. The important settings are shown, but not the complete steps. For complete steps for creating an alarm, see [Example of creating an alarm table and alarm on page 4-22](#). The setting for these alarms are shown:

- Cache Usage alarm
- Port Processor Busy alarm
- LDEV Response Time alarm

### Cache Usage alarm

The following table contains the basic settings for creating a Cache Usage alarm. This alarm uses the record that stores performance data that indicates the operation status of the cache memory for each cache logical partition (CLPR).
Using alarms to monitor operations

### Table 4-2 Cache Usage alarm

<table>
<thead>
<tr>
<th>Option</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>RAID(8.4) (Choose the setting that matches your Agent for RAID (data model))</td>
</tr>
<tr>
<td>Alarm table name</td>
<td>USP VM</td>
</tr>
<tr>
<td>Alarm name</td>
<td>Cache Write Pending</td>
</tr>
<tr>
<td>Alarm message</td>
<td>%ANS CLPR %CVS2 Write pending = %CVS1.2%. Ideally &lt;30%¹</td>
</tr>
<tr>
<td>Monitor whether the value exists</td>
<td>Unselected</td>
</tr>
<tr>
<td>Enable alarm</td>
<td>Selected</td>
</tr>
<tr>
<td>Always notify</td>
<td>Unselected</td>
</tr>
<tr>
<td>Evaluate all data</td>
<td>Unselected</td>
</tr>
<tr>
<td>Always monitor</td>
<td>Selected</td>
</tr>
<tr>
<td>Report alarm when the following damping condition is reached</td>
<td>Selected with 2 occurrences during 2 intervals set</td>
</tr>
<tr>
<td>Alarm conditions</td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>CLPR Summary (PI_CLPS)</td>
</tr>
<tr>
<td>Field</td>
<td></td>
</tr>
<tr>
<td>Abnormal condition</td>
<td>Cache Write Pending Usage % &gt;= 50.000 AND CLPR Number &gt;= 0</td>
</tr>
<tr>
<td>Warning condition</td>
<td>Cache Write Pending Usage % &gt;= 40.000 AND CLPR Number &gt;= 0</td>
</tr>
<tr>
<td>Actions to be executed</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>Abnormal/warning</td>
</tr>
</tbody>
</table>

**Note 1:**

The alarm message variables are set for these conditions:

- %CVS1.2 is Cache Write Pending Usage that is the cache memory allocated to this CLPR (the percentage that is being used by write pending data).
  
  Note that the decimal point in “%CVS1.2” limits the length of the value to two decimal points, eliminating very long numbers in the message.

- %CVS2 is the CLPR Number.

**Processor Busy alarm**

The following table contains the basic settings for creating a Port Processor Busy alarm. This alarm uses the record that stores performance data that indicates the operation status of the on-board processor of the storage system.
### Table 4-3 Processor Busy alarm

<table>
<thead>
<tr>
<th>Choice</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>RAID(8.4) (Choose the setting that matches your Agent for RAID (data model))</td>
</tr>
<tr>
<td>Alarm table name</td>
<td>USP VM</td>
</tr>
<tr>
<td>Alarm name</td>
<td>Port Processor Busy</td>
</tr>
<tr>
<td>Alarm message</td>
<td>%CVS2 MP %CVS3 on %ANS, BUSY RATE IS %CVS1.1 PERCENT&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>Monitor whether the value exists</td>
<td>Unselected</td>
</tr>
<tr>
<td>Enable alarm</td>
<td>Selected</td>
</tr>
<tr>
<td>Always notify</td>
<td>Unselected</td>
</tr>
<tr>
<td>Evaluate all data</td>
<td>Unselected</td>
</tr>
<tr>
<td>Always monitor</td>
<td>Selected</td>
</tr>
<tr>
<td>Report alarm when the following damping condition is reached</td>
<td>Selected with 2 occurrences during 2 intervals set</td>
</tr>
<tr>
<td>Alarm conditions</td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>Processor Summary PI-PRCS</td>
</tr>
<tr>
<td>Field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Processor Busy %</td>
</tr>
<tr>
<td></td>
<td>• Adaptor ID</td>
</tr>
<tr>
<td></td>
<td>• Processor ID</td>
</tr>
<tr>
<td>Abnormal condition</td>
<td>Processor Busy % &gt;= 70.000 AND Adaptor ID &gt;= A AND Processor ID &gt;= 0</td>
</tr>
<tr>
<td>Warning condition</td>
<td>Processor Busy % &gt;= 50.000 AND Adaptor ID &gt;= A AND Processor ID &gt;= 0</td>
</tr>
<tr>
<td>Actions to be executed</td>
<td>Email Abnormal/warning</td>
</tr>
</tbody>
</table>

**Note 1:**

The alarm message variables are set for these conditions:

- %CVS1.1 is Processor Busy % that is the usage rate of the processor
  
  Note that the decimal point in “%CVS1.1” limits the length of the value to one decimal point, eliminating very long numbers in the message.

- %CVS2 is the adaptor ID

- %CVS3 is the processor ID
LDEV Response Time alarm

The following table contains the basic settings for creating an LDEV Response Time alarm. This alarm uses the record that stores the performance data that indicates the execution status of read/write operations on the logical device.

**Note:** The record PI_LDS does not cover all LDEVs. If needed, set alarms with PI_LDS1, PI_LDS2 or PI_LDS3.

### Table 4-4 LDEV Response Time alarm

<table>
<thead>
<tr>
<th>Choice</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>RAID(8.4) *(Choose the setting that matches your Agent for RAID (data model))</td>
</tr>
<tr>
<td>Alarm table name</td>
<td>USP VM</td>
</tr>
<tr>
<td>Alarm name</td>
<td>LDEV Response Time</td>
</tr>
<tr>
<td>Alarm message</td>
<td>for LDEV %CVS2 on %ANS, Avg Response Times--Read: %CVS1.0 uSec (%CVS4.1 MB/S) [1] Write: %CVS3.0 uSec (%CVS5.1 MB/S)</td>
</tr>
<tr>
<td>Monitor whether the value exists</td>
<td>Unselected</td>
</tr>
<tr>
<td>Enable alarm</td>
<td>Selected</td>
</tr>
<tr>
<td>Always notify</td>
<td>Unselected</td>
</tr>
<tr>
<td>Evaluate all data</td>
<td>Unselected</td>
</tr>
<tr>
<td>Always monitor</td>
<td>Selected</td>
</tr>
<tr>
<td>Report alarm when the following damping condition is reached</td>
<td>Selected with 2 occurrences during 2 intervals set</td>
</tr>
<tr>
<td>Alarm conditions</td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>Logical Device summary 1 (P1_LDS1 )</td>
</tr>
<tr>
<td>Field</td>
<td>Read Response Rate</td>
</tr>
<tr>
<td>Abnormal condition</td>
<td>Read Response Rate % &gt;= 100000.000 AND LDEV number &gt;= 0 AND (Write Response Rate &gt;= 0 AND Read Xfer/sec &gt;= 0.050 AND Write Xfer/sec = 0)</td>
</tr>
<tr>
<td>Warning condition</td>
<td>Read Response Rate % &gt;= 500000.000 AND LDEV number &gt;= 0 AND (Write Response Rate &gt;= 0 AND Read Xfer/sec &gt;= 0.050 AND Write Xfer/sec = 0)</td>
</tr>
<tr>
<td>Actions to be executed</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>Abnormal/warning</td>
</tr>
</tbody>
</table>

**Note 1:**

The alarm message variables are set for these conditions:
%CVS1.0 is the Read Response Rate %, which is the average processing time for each read operation request in microseconds
%CVS2 is the LDEV number
%CVS3.0 is the Write Response Rate, which is the average processing time for each write operation request in microseconds
%CVS4.1 is the Read Xfer/sec, which is the read data transfer rate MBps
%CVS5.1 is the Write Xfer/sec, which is the write transfer speed in MBps
Note that the decimal point in "%CVS1.0" limits the length of the value to whole numbers, eliminating very long numbers in the message. The other %CVS variables with decimal points limit the length also by allowing only one decimal point in the values in the message.

Related topics
• These alarms must be associated with an Agent (bound) and activated. For complete steps for creating an alarm, see Example of creating an alarm table and alarm on page 4-22.
• For descriptions of settings, see Descriptions of settings when defining an alarm on page 4-12.
• See the chapter on using alarms in the Tuning Manager User Guide.
  o For variable definitions, see the section on variables to use when creating an alarm table.
  o For restrictions and general steps for creating an alarm, see the section on creating alarms.
  o For reference information, see the section on references for creating an alarm.

Examples of email notifications
The following email notifications have met performance measurement in the alarm condition. A notification is sent to the email address that is set up when you create the alarm. In this example, the address is alert_san_admins@otpp.com.

The variables for the subject line is set up in the in the Prerequisite procedure Example of setting up email alerts for an alarm on page 4-5. The variables for the body of the email is set up during the creation of the alarm. In the following examples, the values of the variables are shown.

Email notification for the Cache Usage alarm
For the Cache Usage alarm, the variables for the email message were set as %ANS CLPR %CVS2 Write pending = %CVS1.2%. Ideally <30%.

The following figure is an example of an email notification that includes the values for the message variables.
Email notification for the Port Processor Busy alarm

For the Port Processor Busy alarm, the variables for the email message were set as for %CVS2 MP %CVS3 on %ANS, BUSY RATE IS %CVS1.1 PERCENT. The following figure is an example of an email notification that includes the values for the message variables.

Email notification for the LDEV Response Time alarm

For the LDEV Response Time alarm, the variables for the email message were set as for LDEV %CVS2 on %ANS, Avg Response Times--Read: %CVS1.0 uSec (%CVS4.1 MB/S) Write: %CVS3.0 uSec (%CVS5.1 MB/S). The following figure is an example of an email notification that includes the values for the message variables.
Monitoring Agents using Performance Reporter

You can use Performance Reporter to remotely monitor the operating status of Agents. You can check the operating status of each agent by clicking its icon in the Agents tree displayed in the navigation pane of the Agents window.

The following figure shows an example of the Agents window of Performance Reporter.
To display Agents window from Performance Reporter

1. In the navigation pane, choose the Agents link.
   
   The Agent tree displays.

2. In the Agent tree, select the desired Agent.
   
   The Agents window displays.

The items in the Agents tree are grouped on an Agent basis by using folders. The icons in the Agents tree that appear in the navigation pane on the left side of the window indicate the operating status of each Agent. You can display related reports and check the alarm status and event history by selecting an Agent in the Agents tree.

**Note:** For more information on monitoring Agents using Performance Reporter, see Tuning Manager User Guide.

### Monitoring Events using Performance Reporter

You can use Performance Reporter to display and monitor events issued by Agents. Events are listed in the chronological order in the Event Monitor window. You can monitor Agent events, Alarm events and Health check events.

In the Event Monitor window, you can monitor the status changes of Agents in real-time because the display is updated automatically.
To display events using performance reporter

1. In the Performance Reporter window, go to menu bar and click **Event Monitor**.

   The Event Monitor window appears as a separate window displaying all types of events as default.

2. From the **View** menu in the Event Monitor window, select the event type you want to display.

   Select the type of event you want to display in the Event Monitor window from among the following items:
   - **All events**
   - **Agent events**
   - **Alarm events**
   - **Health check events**
   - **Health check statuses**

   The default is **All events**.

   Selecting an event type lists the appropriate events. However, when you select **health check statuses**, only the icon, Agent, host name, and status are displayed.

   **Note:** For more information on displaying events, see *Tuning Manager User Guide.*
Analyzing performance bottlenecks

This chapter describes common performance problems. It provides information on how to analyze performance bottlenecks by using Tuning Manager server reports, and offers an example analysis procedure.

This chapter includes the following topics:

- Analyzing performance bottlenecks
- Analysis examples
Analyzing performance bottlenecks

The following topics provide details and pointers for analyzing performance bottlenecks.

Reviewing key points for analyzing performance bottlenecks

An environment that is integrated by storage consolidation contains many servers and storage systems, which can present challenges when identifying performance bottlenecks. For example, it can be difficult to determine which servers use particular storage and which ports are shared by certain servers. However, by understanding the relationship between the configuration of a monitored system and the analysis procedure and procedure policies, you can successfully use the Tuning Manager server to identify and troubleshoot performance degradation.

About the relationship between the system configuration and the analysis procedure

You can only analyze performance information if you understand the configuration of the system that you are monitoring. To illustrate, the following figure provides an example system configuration that a Tuning Manager server is monitoring.

Figure 5-1 Example system configuration that is monitored by a Tuning Manager server

Typically, the locations where performance bottlenecks occur fall into two basic categories:

- Servers (on which applications and device files, for example, are installed)
- Devices other than a server (switches and storage systems, for example)
If a performance bottleneck occurs in one of your applications, analyze the performance information in the following order:

1. Analyze the performance information for the server on which the application is running.
   
   If you find the cause of the performance bottleneck, the analysis ends.
   If you do not find the cause, you can assume that the cause is a device other than a server.

2. Analyze the performance information related to the storage systems that the application uses.
   
   Analyze each item of storage-related performance information for the storage port and parity group until you are able to determine the cause of the performance bottleneck.

For details on key points for analyzing performance bottlenecks and the analysis procedure, see Table 5-1 Guidelines for analyzing a performance bottleneck on page 5-4.

**Resources to which performance bottleneck analysis can be applied**

In performance bottleneck analysis, it is important to determine the order in which resources should be analyzed. The following figure shows the resources to which performance bottleneck analysis can be applied.

![Figure 5-2 Example system configuration that is monitored by a Tuning Manager server](image)

The following table describes performance bottleneck analysis policies and the corresponding analysis procedures.
Table 5-1 Guidelines for analyzing a performance bottleneck

<table>
<thead>
<tr>
<th>Guideline</th>
<th>Procedure</th>
<th>Location</th>
</tr>
</thead>
</table>
| Check whether the performance bottleneck is occurring on a server by performing the following procedure:  
1. Check the server on which the application is running.  
2. Check the resources, other than the server, used by the application.  
Also, use the I/O performance having the most effect on application performance to determine the cause. | Display a list of device files used by the server on which the application is running. | Identifying the host name based on the Oracle instance on page 5-6 Checking the I/O response time on page 5-7 |
| If you do not find any performance bottlenecks on the servers, continue by checking other locations.  
Because storage ports shared by multiple servers are subject to performance bottlenecks, check storage ports. For this check, use the I/O performance of the shared resources to determine the cause. | Check the I/O performance of storage ports for device files. | Checking storage port performance on page 5-9 |
| If the I/O performance of the server on which the application is running is not a problem, check whether any other servers access the same storage port. | Check the I/O performance of the other servers. | Checking connected server performance on page 5-10 |
| Identify any servers placing a heavy load on the storage port. | Identify any servers placing a heavy load on the storage port. | |
| If the I/O performance of the storage port is not a problem, check the I/O performance of the parity group. | Check whether any other servers access the same parity group. | |
| Identify any servers placing a heavy load on the parity group. | | |

Analysis examples

This topic uses an example to illustrate an analysis procedure.

System configuration for monitoring example

The following figure shows the configuration of the system to be monitored in the example of a performance bottleneck analysis.
The following table lists the components of the system to be monitored in the example.

**Table 5-2 Components of the system to be monitored**

<table>
<thead>
<tr>
<th>Component</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>• Gateway A</td>
</tr>
<tr>
<td></td>
<td>• Gateway B</td>
</tr>
<tr>
<td></td>
<td>• CQ-6400-4</td>
</tr>
<tr>
<td>Switch</td>
<td>Switch 103</td>
</tr>
<tr>
<td>Storage</td>
<td>• USP 10225</td>
</tr>
<tr>
<td></td>
<td>• USP 10226</td>
</tr>
</tbody>
</table>

**Procedures used to analyze the performance bottleneck**

The following procedures are used to analyze the performance bottleneck:

- [Identifying the host name based on the Oracle instance on page 5-6](#)
- [Checking the I/O response time on page 5-7](#)
- [Checking storage port performance on page 5-9](#)
Identifying the host name based on the Oracle instance

To identify the host name based on the Oracle instance:
1. In the title area of the application area, click the Create button.
   The Create report window window appears.
2. In the Create report window window, specify a time period during which system operation was stable, and then click the Save button to save the report window.
3. In the title area of the application area, click the Create button.
   The Create report window window appears.
4. In the Create report window window, specify the time period during which the problem occurred, and then click the Save button to save the report window.
5. In the explorer area, choose Resources and then Applications.
6. In the navigation area, choose Oracle.
   Oracle instances are listed in the information area (correlation view).
   You can see that an instance named HTM is running on Gateway B.
7. In the explorer area, choose Resources and then Hosts.
8. In the navigation area, select Gateway B.
   The configuration and capacity information about the resources related to Gateway B is displayed in list format in the information area (correlation view).
9. Click the Correlation Wizard button.
   The Correlation Wizard - Gateway B window appears.
10. Select the check boxes of the resource types you want to analyze, and then, from the drop-down list, select the metric to be analyzed for each resource.
11. For Primary Report Window, specify the report window you saved in step 2.
13. Click the Next button.
   The capacity and performance information for the metrics that you chose for the selected resources is displayed for the time periods specified in Primary Report Window and Secondary Report Window. Compare the data for the normal operating period to the data for the abnormal operating period to see which metric values for the resources show significant differences.
Checking the I/O response time

To check the I/O response time:

1. Redisplay the Main Console window. In the information area (correlation view), choose the Device Files tab, and then click the Performance Summary button.
   
   The Performance Summary - Device Files window appears. This window displays the performance data for the time displayed in this window.

2. If you want to change the time frame to the time frame in which the problem occurred, click the displayed time.
   
   The Edit - Report Window window appears.

3. Specify a time period that includes the occurrence of the problem, and then click the OK button.
   
   The information displayed in the Performance Summary - Device Files window changes to the performance data for the time at which the problem occurred.

   In the performance information list displayed in the Performance Summary - Device Files window, choose the I/O Response Time header.

4. The rows are sorted in descending order of the I/O Response Time values. You can see that the I/O Response Time value for device file 8 is the largest.

5. Redisplay the Main Console window, and then, in the navigation area, choose Device Files.

6. In the information area, choose the Device Files tab, and then select Device file 8.
   
   Device file 8, which was hidden, is displayed in the navigation area. Also, a report about device file 8 is displayed in the report area.

7. Click the IOPS graph that is displayed as a thumbnail on the Dashboard page in the information area.
   
   The thumbnail is displayed as a full size graph.

8. Check the performance data trends.

9. In the global tasks bar area, choose Go and then Performance Reporter to check more detailed trend information.

10. In the Information frame, choose User Reports.
    
    A list of predefined reports appears.

11. Select I/O Response Time.
    
    The Show Options window appears.

12. In the Show Options window, specify the values shown in the following table.
I/O Response History appears for all device files on Gateway B.
In the displayed report, check the ID of device file 8.
This example assumes that the ID of device file 8 (checked above) is
8?H: (? indicates a space).

13. In the Show Options window, specify the values shown in the following table.

**Table 5-3 Settings in the Show Options window for checking IDs**

<table>
<thead>
<tr>
<th>Item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings for</td>
<td>Start Time</td>
</tr>
<tr>
<td>the report</td>
<td>End Time</td>
</tr>
<tr>
<td>display</td>
<td>Report Interval</td>
</tr>
<tr>
<td>period</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td>Drive Bytes/sec</td>
</tr>
</tbody>
</table>

**Note:**
Since you found in step 4 that the I/O Response Time value for device file 8 was the largest of the device files used for Gateway B, specify 8.

14. In the Show Options window, specify the values shown in the following table.

**Table 5-4 Settings in the Show Options window for checking the I/O response time**

<table>
<thead>
<tr>
<th>Item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings for</td>
<td>Start Time</td>
</tr>
<tr>
<td>the report</td>
<td>End Time</td>
</tr>
<tr>
<td>display</td>
<td>Report Interval</td>
</tr>
<tr>
<td>period</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td>Drive Bytes/sec</td>
</tr>
</tbody>
</table>

**Note:**
Main Console and Performance Reporter manage different IDs. In this specification, you know that the device file ID in Main Console is 8, but do not know the ID in Performance Reporter. To display a list of the device file IDs managed by Performance Reporter, specify 0 for Drive Bytes/sec.

I/O Response History appears for device file 8 on Gateway B. You must check whether the increase in the I/O Response Time value was caused by shared resources (ports and parity groups).
Checking storage port performance

To check the performance of the storage port:

1. Redisplay the Main Console window. In the information area (correlation view), choose the Ports tab and then CL4-E, which is the port for device file 8.
   
   Information about CL4-E appears in the report area.

2. Click the IOPS graph that is displayed as a thumbnail on the Dashboard page in the information area.
   
   The thumbnail is displayed as a full size graph.

3. Check the performance data trends.

4. Click the Performance Reporter button to check more detailed trend information.
   
   Performance Reporter starts.

5. In the Information frame, choose User Reports.
   
   The predefined report list appears.

6. Choose I/O Rate.
   
   The Show Options window appears.
7. In the Show Options window, specify the values shown in the following table.

**Table 5-5 Settings in the Show Options window for checking the storage port performance**

<table>
<thead>
<tr>
<th>Item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings for the report display period</td>
<td>Start Time</td>
</tr>
<tr>
<td></td>
<td>End Time</td>
</tr>
<tr>
<td></td>
<td>Report Interval</td>
</tr>
<tr>
<td>Filter</td>
<td>Port Name</td>
</tr>
</tbody>
</table>

Xfer Rate History for CL4-E appears. You need to determine the server that caused the increase in the Transfer Rate value for CLL4-E.

![Xfer Rate History for CL4-E](image)

**Figure 5-5 Xfer Rate History for CL4-E**

**Checking connected server performance**

To check the performance of the connected server:

1. Redisplay the Main Console window. In the information area (correlation view), choose the Hosts tab.
   All the device files that use CL4-E are listed.
2. Click the Performance Summary button.
The Performance Summary - CL4-E window appears. This window displays the performance data for the time displayed in this window.

3. If you want to change the time frame to the time frame in which the problem occurred, click the displayed time.
   The Edit - Report Window window appears.

4. Specify a time frame that includes the occurrence of the problem, and then click the OK button.
   The information displayed in the Performance Summary - CL4-E window changes to the performance data for when the problem occurred.

5. Choose Transfer in the table header for the performance data list displayed in the Performance Summary - CL4-E window.
   Data is sorted in descending order of Transfer values. After sorting data in the Transfer column in descending order, you can see that the Transfer value for device file 5 in CQ6400-4 is the largest.

6. Redisplay the Main Console window, and then click the Performance Reporter button.
   Performance Reporter starts.


8. In the Information frame, choose User Reports.
   A list of predefined reports appears.

   The Show Options window appears.

10. In the Show Options window, specify the values shown in Table 5-6 Settings in the Show Options window for checking the transfer rate history on page 5-11.

   Note: Specify 5 for the Filter ID. Transfer Rate History appears for all device files on CQ6400-4. In the displayed report, check the ID of device file 5. This example assumes that the ID of device file 5 (checked above) is 5?G: (? indicates a space).

11. In the Show Options window, specify the values shown in the following table.

    Table 5-6 Settings in the Show Options window for checking the transfer rate history

    | Item                        | Settings                                                                 |
    |------------------------------|--------------------------------------------------------------------------|
    | Start Time                   | To clarify how the performance information changed, specify times before and after the deterioration in Oracle performance seemed to begin |
    | End Time                     |                                                                          |
    | Report Interval              | Minute                                                                   |

Analyzing performance bottlenecks 5–11
Hitachi Tuning Manager Getting Started Guide
Transfer Rate History for CQ6400-4 appears.

You can see that the I/O value for CQ6400-4 rose sharply.

This means that the performance deterioration on Gateway B was caused by a rapid increase in I/O by CQ6400-4, which was using the same port as Gateway B.
Frequently asked questions

This chapter answers the questions that are often raised when working with the Tuning Manager series. If you have a question that is not addressed here or elsewhere in the Tuning Manager series documentation set, please check our Web site at: http://www.hds.com, or contact the Hitachi Data Systems Support Center.

This chapter includes the following topics:

- Login issues
- IP addresses
- Data collection
- Agent management
- Resource management
- Report handling
- Error detection
- Operations changes
- Data recovery
Login issues

This section provides you answers to frequently asked questions about login issues.

- My login to the Tuning Manager failed. How should I proceed further?

  If an attempt to login to the Tuning Manager server fails, make sure that the Tuning Manager server services are running, or contact your system administrator. For details on how to start the Tuning Manager services, see Tuning Manager Server Administration Guide. Also, before you start using the Tuning Manager Server GUI, confirm that your browser options are set up correctly. For more information on how to adjust your browser's settings, see Tuning Manager User Guide.

- Can I access multiple Tuning Manager servers simultaneously by opening multiple browser windows from my computer?

  No. Tuning Manager server operations from multiple browser windows on the same client are not supported regardless of whether the Tuning Manager servers you attempt to login to are on a single server or multiple servers.

IP addresses

This section provides answers to frequently asked questions about specifying IP addresses when working with the Tuning Manager series.

- Does the Tuning Manager server use physical IP addresses to manage Agents in cluster configurations?

  No, the Tuning Manager server uses logical IP addresses for its communication with Agents in cluster configurations.

- If I want to use the Tuning Manager series in a network environment that consists of multiple LANs, how do I specify IP addresses used for communications between the Tuning Manager server and Agents?

  Specify the host names and IP addresses in the `jpchosts` file. For details, see the chapter that describes how to set up the Tuning Manager series in the Tuning Manager Installation Guide.

Data collection

This section provides answers to frequently asked questions about data collection when working with the Tuning Manager series.

- If I want to collect data from the Hitachi HUS100/AMS2000/AMS/WMS/SMS series is there anything I need to set up in advance?

  Start Storage Navigator Modular. Open the Performance Statistics dialog box, and then select all the check boxes to collect performance statistics data.

Agent management

This section provides answers to frequently asked questions about managing Agents when working with the Tuning Manager series.
• What is the best practice for naming Agent instances?
  We recommend that you specify a unique name for each instance in your system to identify monitoring targets. For example, when determining an instance name for Agent for RAID, you can use the product name and serial number of the monitored storage system as follows:
  o Product name: Hitachi USP
  o Serial number: 14009
  o Recommended instance name: USP14009

• How can I set up Agents so that they automatically start on a reboot in an AIX environment?
  Perform the following procedure:
  o Copy the file jpc_start.model to the file jpc_start as follows:```
cd /opt/jplpccp -p jpc_start.model jpc_start
chmod 555 jpc_start
```
  o Execute the following command:```
mkitab “jplpc:2:wait:/etc/rc.jpl_pc >/dev/console 2>&1”
```

• If I want to change Collection Manager or Agent settings by using Performance Reporter, do I need to restart the services of Collection Manager or the Agent?
  No, you do not need to restart those services.

• When I restart the Tuning Manager server, the Event Monitor window in Performance Reporter is updated. How can I display the previous event information?
  You can view the previous event information from the Event History window in Performance Reporter.

### Resource management

This section provides answers to frequently asked questions about managing resources when working with the Tuning Manager series.

• From Performance Reporter, if I want to examine the details of a resource that is monitored by Main Console, how do I determine which Agent instance monitors the resource?
  In Performance Reporter, the instance names for an Agent are displayed under the name of that Agent in the navigation pane. Therefore, we recommend that you specify a unique name for each Agent instance to help you identify the resource being monitored by the Agent instance.

   The following is an example of how an instance name of Agent for RAID is displayed in the navigation pane of Performance Reporter:
   o Monitored storage system: Hitachi USP
   o Agent instance name: USP14009
   o Agent instance name displayed on the navigation pane of Performance Reporter: **DA1USP14009[host-name]**

• How can I reduce the number of LDEVs that are being monitored by the Tuning Manager series?
The method you can use to reduce the number of LDEVs differs depending on your purpose:

- To improve usability of the GUI by limiting the number of displayed LDEVs:
  - In Main Console, click the **Filter** button to modify filtering conditions on resources. In Performance Reporter, when creating or editing report definitions, you can specify the filtering conditions for the desired fields.

- To reduce the amount of the Store database being used:
  - Change the settings in the logical device definitions file (ldev_filter.ini), which is provided by Agent for RAID. For details, see the *Tuning Manager Agent Administration Guide*.

- Which GUI do I need to use to view LDEV labels in the Tuning Manager series?
  - Use Main Console.

- Which GUI do I need to use to monitor a host storage domain (HSD) in the Tuning Manager series?
  - Use Main Console.

- Which resources' response times can I check by using Main Console?
  - You can check response times for the following resources:
    - Device files
    - Logical drives

**Report handling**

This section provides answers to frequently asked questions about creating reports when working with the Tuning Manager series.

- Both Main Console's reporting commands and Performance Reporter's **jpcrpt** command can be used for creating reports. How do I decide which command to use?
  - If you want to output only performance data, use Performance Reporter's **jpcrpt** command.
  - If you want to output configuration information or capacity information, use Main Console's reporting commands.

- Can I import report definitions that were exported by an earlier version of Performance Reporter to a later version of Performance Reporter?
  - You can export and import report definitions regardless of the version of Performance Reporter.

**Error detection**

This section provides answers to frequently asked questions about detecting errors when working with the Tuning Manager series.

- Is there any method I can use to remotely detect errors that have occurred the Tuning Manager series while it is running?
The Tuning Manager series provides functionality for sending notification (for example, by email) when an error in the Tuning Manager series is detected.

For details about how to detect errors in the Tuning Manager server, see the description of system reports in the Tuning Manager Server Administration Guide. For details about how to detect errors in Agents, see the Tuning Manager Agent Administration Guide.

- A polling error has been detected. What should I do first?
  Use the logs output by Main Console to determine the cause of the error, and then resolve the problem.
  For details about logs output by Main Console, see the Tuning Manager Server Administration Guide.

**Operations changes**

This section provides answers to frequently asked questions about making operations changes when working with the Tuning Manager series.

- Can I perform polling more than once per day?
  We recommend that you perform polling once per day.
  Usually, configuration information and capacity information, which are collected by polling, do not change significantly in a short period of time. Also, performance data is collected from Agent Store databases in real-time, and is not collected by polling. Therefore, performing polling once per day is sufficient.
  If you want to perform polling more than once, estimate the total capacity of the Tuning Manager server databases to make sure that drive space will be sufficient.

- Will changing the host on which Device Manager is installed cause problems?
  You can change the host without problems. After you change the Device Manager host, however, you need to set up both the Tuning Manager server and Device Manager again. For details about how to set up the Tuning Manager server, see the chapter that describes how to set up the Tuning Manager series in the Tuning Manager Installation Guide. For details about how to set up Device Manager, see the manuals for Device Manager.

**Data recovery**

This section provides answers to frequently asked questions about recovering data when working with the Tuning Manager series.

- If an error occurs in a database of the Tuning Manager series, how do I recover from the error?
  If an error occurred in the Store database of an Agent, use the `jpcresto` command to restore the latest backup data, which was obtained by the command `jpcctrl backup`. If an error occurred in the Tuning Manager server database, use the `hcmdsdb` command to restore the latest backup.
data, which was obtained by the `hc-mdsbackups` command. To facilitate recovery in case of an error, we recommend that you back up the databases regularly.
Symbols

%CVS variable description 4–12

A

Action Handler property 4–5, 4–11
actions performed when alarms are triggered 4–2
Agent for RAID 6–3
agents
setting up and managing 3–1
agents, configuring for automatic restart in AIX 6–3
agents, determining resources monitored by 6–3
alarm event, described 4–2
alarms, creating 4–2
%CVS variable description 4–12
actions performed when triggered 4–2
always notify, description of 4–18
configuring email 4–5
configuring host to run commands 4–11
configuring an SNMP trap destination 4–8
damping, description of 4–21
data model version 4–16
definition of 4–2
description of monitor whether a value exists 4–17
descriptions of settings 4–12
monitoring time range, description of 4–20
overview 4–1, 4–2
task flow 4–3
alarms, example
configuring an SNMP trap destination 4–8
configuring email 4–5
configuring host to run commands 4–11
prerequisite tasks 4–5
alarms, examples
configuring email 4–5
configuring host to run commands 4–11
alarms, always notify, description of 4–18
AMS200/AMS/WMS/SMS series, monitoring 6–2

B

backing up data 6–5
binding an alarm table
definition of 4–2

C

collecting data from devices 6–2
configuring an alarm to send an SNMP trap 4–8
configuring agents to automatically restart in AIX 6–3
configuring email for alarms, example 4–5
configuring host to run commands for alarms 4–11
Correlation report, about 2–5
creating reports 6–4
customizing alarms, example 4–22

damping, description of 4–21
data model version used in alarms 4–16
data, backing up 6–5
data, restoring 6–5
descriptions of alarm settings 4–12
detecting errors remotely 6–4
determining which resources an agent monitors 6–3
Device Manager host, changing 6–5

E

example
copying to create an alarm or alarm table 4–22

F

Forecast report, about 2–5

H

hcmdsbackups command 6–6
hcmdsdb command 6–5
HiRDB 2–2
Historical report, about 2–5
host storage domain, monitoring 6–4

I
importing and exporting report definitions, about 6–4
instance names for Agents, locating 6–3
IP addresses, specifying for communication 6–2

J
jpcctrl backup command 6–5
jpcrpt command 6–4
jphosts command 6–2
jpisto command 6–5

L
labels, LDEVs location of 6–4
LDEVs
  reducing the number monitored by Tuning Manager 6–3
  reviewing labels for 6–4
locating an Agent’s instance names 6–3
locating LDEV labels 6–4

M
Main Console 2–2
metrics
  data retention setup 3–16
modifying polling frequency 6–5
monitor whether a value exists, description of 4–17
monitoring a host storage domain 6–4
monitoring time range, description of 4–20

P
Performance Reporter 2–2
about 2–2
  launching 2–2
  reports 2–4
Performance Reporter properties 4–8
Performance summary report, about 2–5
polling
  setting polling offset options 3–10
  setting polling retry options 3–11
polling frequency, modifying 6–5
prerequisites for creating alarms 4–5

R
reducing the number of monitored LDEVs 6–3
remote error detection 6–4
reports, creating 6–4
restarting agents automatically in AIX 6–3
restoring backed-up data 6–5
retention
  setting data retention periods 3–15

S
setting
  metrics data retention 3–16
  notifications 4–2
  polling offset options 3–10
  polling retry options 3–11
SNMP trap, configuring an alarm for 4–8
specifying IP addresses for communication 6–2
Storage Navigator Modular, starting 6–2

T
threshold notifications 4–2
Trap Generator property 4–5
Trap Generator service property 4–8
Trend chart report, about 2–5
Tuning Manager server viewers 2–2

U
user management 2–1

V
viewers, Tuning Manager server 2–2